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Abstrakt 

Diplomová práce je zaměřena na určení záplavového území a hydrotechnické 

posouzení Zákolanského potoka v katastrálním území obce Noutonice. Nejprve se 

práce věnuje rozboru jednotlivých částí hydrologické studie povodí, včetně objektů 

vyskytujících se na malých vodních tocích a seznamuje s problematikou povodní. Dále 

je zde popis základů matematického modelování v hydrologii, včetně klasifikace 

modelů a představení softwarových alternativ pro tvorbu hydrodynamických modelů. 

Pozornost je věnována zejména programu HEC-RAS, který je v této práci používán. 

Součástí práce je také popis Zákolanského potoka a jeho povodí. Další část práce je 

pak zaměřena na přípravu podkladových dat v programu ArcGIS s využitím nadstavby 

HEC-GeoRAS, převedení vstupních dat do modelovacího programu HEC-RAS a 

zpracování výstupů modelu v programu ArcGIS. Výstupem práce je hydrotechnické 

posouzení koryta včetně objektů na něm a stanovení záplavové čáry pro 5-leté,  

20-leté, 50-leté a 100-leté průtoky (Q5, Q20, Q50, Q100), které lze využít pro předpověď 

rozsahu zaplavených území při povodních v tomto katastrálním území. 
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Abstract 

 

The thesis is focused on the flooded area determination and the hydro technical 

assessment of the Zákolanský stream, which is located in the cadaster area 

of the Noutonice municipality. To begin with, the work is focusing on the analysis 

of the individual parts of the river basins hydrological study, including the objects 

occurring on small watercourses and the problems of the floods. Furthermore, there is 

a mathematical modeling basics description in hydrology, including the classification 

of models and the introduction of software alternatives for the creation 

of hydrodynamic models. Attention is paid to the HEC-RAS program, which is used 

in this work. Part of the thesis is also a description of the Zákolanský stream and its 

basin area. The next part of the thesis is focused on the preparation of the underlying 

data in ArcGIS using the HEC-GeoRAS extension, the transfer of the input data into 

the HEC-RAS modeling program and the processing of the ArcGIS model outputs. 

The output of the work is the hydro technical assessment of the channel, including 

the objects on it and the determination of the flood outline for the 5-year, 20-year,  

50-year and 100-year flows (Q5, Q20, Q50, Q100) that can be used to predict the extent 

of flooded areas during floods in this cadaster area. 
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1 Úvod 

Zákolanský potok se nachází ve Středočeském kraji na pomezí Kladenska  

a Prahy-západ, pramení jihovýchodně od Kladna, u obce Pletený Újezd a ústí 

do Vltavy ve městě Kralupy nad Vltavou. Svojí charakteristikou se dá zařadit mezi 

malá povodí, na těchto tocích jsou jen výjimečně k dispozici přímá hydrometrická 

pozorování. Tok prochází relativně rovnou, intenzivně zemědělsky obhospodařovanou 

krajinou. Důsledkem opakovaného poškozování nešetrnými melioračními zásahy 

v minulosti je odtok z povodí zrychlený, což bývá příčinou častých záplav v okolních 

obcích. Od tvorby těchto úprav se však již upustilo a na toku dochází k postupné 

renaturaci. Pro hodnocení povodňových situací na takovýchto tocích lze uplatnit právě 

matematické modely, jejichž využití v praxi je závislé na dostupnosti vstupních 

parametrů. Na toku se nachází maloplošné chráněné území Zákolanský potok 

v katastru obce Noutonice, kterým se má diplomová práce zabývá. Jedná se o přírodní 

úsek, který je evropsky významnou lokalitou s výskytem raka kamenáče 

(Austropotamobius torrentium). V této lokalitě se nachází kromě rekreačních objektů, 

stavby, které nelze opominout, a to Dolský mlýn a Nový mlýn. Za Novým mlýnem se 

nad potokem vypíná rekonstruovaný kamenný viadukt. V úseku před Novým mlýnem 

byl břeh stabilizován haťováním, díky tomu byly vytvořeny přirozené úkryty pro vodní 

živočichy a břeh má nyní přírodní, dlouhodobě se obnovující přírodní charakter. 

Současně byla v roce 2015 dokončena nová dřevěná lávka přes tento úsek 

Zákolanského potoka vypletená hrubými lískovými pruty. Úkolem mojí práce je 

vytvoření modelových situací, vynesením záplavových čar a hydrotechnické 

posouzením objektů, které lze využít pro předpověď rozsahu zaplavených území 

při povodních v tomto katastrálním území. 
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2 Cíle práce 

Cílem této práce je určení záplavového území a hydrotechnické posouzení vodního 

toku Zákolanský potok v katastrálním území obce Noutonice. Součástí práce bude 

popis hydrologické studie povodí včetně objektů vyskytujících se na malých vodních 

tocích a seznámení se s problematikou povodní. Cílem práce je sestavení 

hydrodynamického modelu a určení záplavových čar pro N-leté průtoky. Práce bude 

zaměřena na přípravu podkladových dat v programu ArcGIS s využitím nadstavby 

HEC-GeoRAS, převedení vstupních dat do modelovacího programu HEC-RAS 

a zpracování výstupů modelu v programu ArcGIS.  

Záplavové čáry budou stanoveny pro 5-leté, 20-leté, 50-leté a 100-leté průtoky 

(Q5, Q20, Q50 a Q100), které lze využít pro předpověď rozsahu zaplavených území 

při povodních v tomto katastrálním území. Dalším výstupem práce bude 

hydrotechnické posouzení koryta včetně objektů na něm. To slouží k nalezení 

problematických míst na toku, ve kterých může docházet při povodňových stavech 

k zaplavení přilehlého území. 
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3 Literární rešerše 

3.1 Povodí 

Pro stanovení srážko-odtokových procesů se území rozděluje na dílčí celky 

označované jako povodí. Povodí jsou od sebe oddělena tzv. rozvodnicí a vždy se 

vztahuje k profilu na toku. Rozvodnice vede od profilu přes nejvyšší místa jako např. 

vrcholy a hřebeny horstev a vrací se zpátky do stejného profilu na toku, ze kterého 

vyšla. Tvoří tedy uzavřenou oblast, ze které veškerá spadlá voda vytvářející odtok, 

odteče do říčního systému tohoto povodí a proteče jeho uzávěrovým profilem. (Kemel 

1996) Povrchové a podpovrchové vody však nemusí mít povodí stejné, proto se 

rozlišuje rozvodnice orografická (pro povrchové vody) a hydrogeologická (pro vody 

podpovrchové). Orografická rozvodnice se určuje poměrně snadno za pomoci mapy 

terénu (Obr. 1). Pro stanovení rozvodnice 

hydrogeologické, je však zapotřebí 

geologický průzkum, který stanoví 

geologické složení nepropustných vrstev. 

Rozdíl těchto rozvodnic je ve většině 

případů zanedbatelný, proto se používá 

spíše orografická rozvodnice. 

(Hubačíková 2002) 

Mezi základní hydrologické údaje se řadí plocha povodí, dlouhodobá průměrná roční 

výška srážek na povodí, dlouhodobý průměrný průtok, M–denní průtoky, N–leté 

průtoky s dobou opakování N = 1 až 100 let. (ČSN 751400) Plocha povodí se obvykle 

stanovuje planimetrováním z map v měřítku 1 : 25 000 a udává velikost plochy 

půdorysného průmětu povodí do vodorovné roviny. M-denní průtoky jsou odvozené 

z čáry překročení průměrných denních průtoků, kde M označuje počet dní, po které je 

daný průtok dosažen nebo překročen. N-leté průtoky naopak vychází z čáry opakování 

ročních kulminačních průtoků a informují o kulminačním (největším) průtoku 

povodňové vlny, přičemž N značí počet let, během kterých je tento průtok 

v dlouhodobém průměru jednou dosažen nebo překročen. (Hrádek, Kuřík 2008) 

Změnu zásoby vody v rámci povodí lze určit z bilanční rovnice (1), která vyjadřuje 

vztah mezi množstvím srážek (HS), odtokem (HO), výparem (HV) a změnou zásoby 

vody (R). Tyto bilanční prvky bývají nejčastěji vyjadřovány výškou, odpovídající 

Obr. 1 Orografická rozvodnice (Hubačíková 2002) 
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vrstvě pokrývající plochu povodí a musí se vztahovat ke stejnému časovému období. 

(Pokorná, Zábranská 2008) 

   

 𝐻𝑆 = 𝐻𝑂 + 𝐻𝑉 ± 𝑅 (1) 

   

Základní časovou jednotkou používanou v hydrologii je hydrologický rok. Tento rok 

začíná v různých zeměpisně-klimatických pásmech odlišně, a to vždycky tak, aby 

všechny srážky spadlé během jednoho hydrologického roku v tomto roce také odtekly. 

(Němec 1965) Vlivem střídání ročních období je hydrologický rok proti kalendářnímu 

posunutý. V České republice hydrologický rok začíná 1. listopadu předešlého roku a 

končí 31. října běžného kalendářního roku. Pevné srážky spadlé během zimního 

období by tedy měly v rámci jednoho hydrologického roku jak spadnout na povrch, 

tak i roztát a odtéct z povodí. (Hubačíková 2002) 

Mimo zmíněných hydrologických údajů, lze povodí charakterizovat na základě jeho 

tvaru, umístění či dalších poměrů specifických pro danou lokalitu. Dalším hlediskem 

pro popis povodí může být akumulovaná voda, vzájemné umístění a napojení všech 

toků v daném povodí nebo i antropogenní činnost. (Hrádek, Kuřík 2008) 

3.1.1 Charakteristiky povodí 

Geometrické charakteristiky povodí 

Mezi hlavní geometrické charakteristiky povodí patří 

již zmíněná plocha povodí. Postupný nárůst plochy 

povodí směrem po toku spolu se symetričností bývá 

znázorněn v grafu vývinu povodí (Obr. 2). 

Při sestrojování grafu vývinu povodí se nejprve 

vykreslí svislá úsečka, která ve vhodném měřítku 

znázorňuje délku hlavního toku v povodí. Spolu 

se staničením hlavního toku se do grafu vynáší 

ve vodorovném směru rozloha povodí pravé a levé strany vztažená k tomuto staničení. 

Jelikož v České republice je zvyklostí počítat staničení proti proudu, bude úsečka grafu 

vývinu povodí ve staničení 0,0 km odpovídat ploše celého povodí s rozdělením 

na pravou a levou část. (Pokorná, Zábranská 2008) Díky představám o rozloze pravé 

Obr. 2 Graf vývinu povodí (Pokorná, 

Zábranská 2008) 
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(𝐹𝑃) a levé (𝐹𝐿) části povodí, lze stanovit součinitel asymetrie (a) pomocí rovnice (2), 

kde F představuje celkovou plochu povodí. (Hrádek, Kuřík 2008) 

   

 
𝑎 =

𝐹𝐿 − 𝐹𝑃
𝐹𝐿 + 𝐹𝑃

=
𝐹𝐿 − 𝐹𝑃
𝐹

 (2) 

   

Povodí, ať už symetrické nebo nesymetrické, mívá tvar více či méně protáhlého listu. 

Míru protažení lze popsat koeficientem tvaru povodí (rovnice 3), kde B je průměrná 

šířka povodí a L je jeho délka. Nejčastěji tento poměr bývá v rozmezí 1 : 2 až 1 : 4. 

Tvar povodí bývá někdy také popisován koeficientem udávajícím poměr délky kruhu, 

který má plochu stejně velkou jako povodí, vůči délce rozvodnice povodí. Dalším 

používaným způsobem stanovení koeficientu tvaru povodí je poměr plochy povodí 

a plochy kruhu, který má stejný obvod 

jako povodí. (Kemel 1996) Znázornění 

zmíněných i dalších přístupů 

ke stanovení koeficientu tvaru povodí 

je uvedeno na Obr. 3. Podle hodnoty 

součinitele tvaru povodí, lze rozdělit 

povodí o rozloze 5–50 km2 na povodí 

protáhlá (𝛼 < 0,24), přechodného typu 

(𝛼 = 0,24 − 0,26) a vějířovitá  

(𝛼 > 0,26). (Hrádek, Kuřík 2008) 

   

 
𝛼𝑇 =

𝐵

𝐿
=
𝐵 ∗ 𝐿

𝐿2
=
𝐹

𝐿2
 (3) 

   

 

  

Obr. 3 Schematizace tvaru povodí (Hrádek, Kuřík 2008) 
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 Orografické poměry povodí 

Výškové a sklonové poměry popisují orografické charakteristiky povodí. Spolu 

se zeměpisnou polohou povodí a uzávěrového profilu ovlivňují klimatické 

a meteorologické charakteristiky. Sklonové poměry také ovlivňují rychlost odtoku 

vody z povodí. Údaje potřebné pro stanovení orografických poměrů se zjišťují 

z topografických (vrstevnicových) map. (Hrádek, Kuřík 2008) 

Pro znázornění výškových poměrů povodí 

bývají používány hypsografické křivky 

(někdy též nazvané hypsometrické). Jak je 

na Obr. 4 znázorněno, na svislé ose jsou 

vyneseny nadmořské výšky a od nejvyšší 

vrstevnice směrem k nižším se 

ve vodorovném směru vykresluje plocha povodí, která je při této nadmořské výšce 

dosažená nebo překročená. (Nypl, Kuráž 1992) Jestliže výškový krok vrstevnic 

označíme jako ∆ℎ a součet délek vrstevnic jako ∑ 𝑙, pak můžeme zjistit průměrný 

sklon povodí 𝐼𝑜 z rovnice (4). (Pokorná, Zábranská 2008) 

   

 
𝐼𝑜 =

∆ℎ ∗ ∑ 𝑙

𝐹
 (4) 

   

3.1.2 Geologické a půdní poměry povodí 

Na rozdělení odtoku vody ze srážek na povrchový a podpovrchový odtok mají velký 

vliv geologické a půdní poměry. Jsou-li horniny v povodí dobře propustné, umožňují 

během vydatných srážek lepší odvádění vody do spodních horizontů, čímž snižují 

kulminační průtok na toku během povodní. Podle míry propustnosti lze horniny 

rozdělit na propustné, polopropustné nebo nepropustné. (Němec 1965) Rychlost 

vsakování je ovlivněna také sklonitostí horninových vrstev, ale i půdními poměry 

na povrchu. Pomocí součinitele filtrace (𝑘𝑓) lze propustnost půdy označit jako velmi 

nízkou, nízkou, mírnou, střední, vysokou nebo velmi vysokou. Klasifikace zemin 

v závislosti na koeficientu propustnosti je uvedena v Tab. 1 (Hrádek, Kuřík 2008) 

Vysoce propustné půdy dobře pohltí vodu ze srážek a odvedou ji do nižších vrstev, 

tím zvýší podzemní odtok a zároveň sníží odtok povrchový. Naopak půdy s nízkou 

Obr. 4 Hypsografická křivka (Nypl, Kuráž 1992) 
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propustností přispívají k nerovnoměrnému odtoku povrchové a podzemní vody, 

jelikož vodu ze srážek špatně vsakují a spíše zrychlují povrchový odtok z povodí. 

Nestrukturní půdy vodu téměř nevsakují a na povrchu se tak vytvoří srážkovou vodu 

nepropustná vrstva, která rychle odtéká po povrchu a napomáhá tak vzniku prudkých 

povodňových vln s vysokými kulminačními průtoky. (Sommer 1981) 

Tab. 1 Klasifikace zemin podle propustnosti (Hrádek, Kuřík 2008) 

Zemina kf [m.s-1] kf [m.den-1] Označení propustnosti 

Jíl 1.10-8 – 1.10-7 < 0,03 Velmi nízká 

Hlína 1.10-7 – 1.10-6 0,03 – 0,15 Nízká 

Písčitá hlína 1.10-6 – 5.10-6 0,15 – 0,5 Mírná 

Hlinitý písek 1.10-6 – 2.10-5 0,5 – 2,0 Střední 

Jemnozrnný písek 1.10-5 – 5.10-5 2,0 – 6,0 Vysoká 

Středně zrnný písek 1.10-4 – 5.10-4 > 6,0 Velmi vysoká 

Drobný štěrk 1.10-4 – 1.10-3 > 6,0 Velmi vysoká 

Hrubý štěrk s pískem 1.10-3 – 3.10-2 > 6,0 Velmi vysoká 

3.1.3 Vegetační kryt povodí 

Obecně se rostlinná pokrývka na povodí považuje za příznivou. Vegetační pokryv 

na povodí zmírňuje erozi, zlepšuje vsakování vody díky kořenovému systému a listy 

přikrývají půdu, čímž snižují výpar z půdy. Na druhou stranu v některých případech 

mohou rostliny na odtokové poměry i negativní vliv, zejména odčerpáváním 

podpovrchových vod. (Sommer 1981) 

Kromě nižších rostlin je pro povodí přínosný zdravý, vyspělý a správně situovaný 

smíšený les. Takový les pokrývá půdu dostatečnou vrstvou hrabanky a humusu, díky 

které zadrží, nechá zasáknout a se zpožděním uvolní značné množství ze srážek. 

Zalesněná povodí mají tedy nižší hodnoty kulminačních průtoků při N-letých 

průtocích, než pokud by povodí bylo nezalesněné. (Kemel 1996) Pokud je povodí 

zalesněné pouze částečně, pak kladný nebo záporný vliv na odtok záleží na umístění 

lesa. Díky zastínění se v lese drží sněhová pokrývka déle a tím pádem kulminační 

odtok z tohoto území je pozdější. Je-li les umístěn v horní části povodí, pak voda 

z nezalesněné části odteče do toku dříve, než voda ze sněhu zadrženého v lese. 

Pokud se však les nalézá v nižší části povodí, pak hrozí, že začne voda odtávat 

a účastnit se odtoku v okamžiku, kdy do stejného místa začne přitékat voda 
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ze vzdálenějších, ale nezalesněných, území. Setkání kulminačního odtoku 

z nezalesněné části povodí s kulminačním odtokem z lesa může mít za následek větší 

celkové kulminační průtoky, než pokud by v povodí les nebyl. (Hubačíková 2002) 

3.1.4 Akumulace vody v povodí a antropogenní činnost 

Hydrologickou bilanci povodí a charakter (velikost, průběh) povrchového odtoku také 

ovlivňuje akumulace vody v povodí. Mimo již zmiňované retenční vlastnosti lesa jsou 

pro zadržení vody v povodí důležitá jezera, vodní nádrže, bažiny i povrchové deprese. 

(Hrádek, Kuřík 2008) Lidé v povodí upravují toky, staví nádrže a realizují 

agrotechnické či lesnické úpravy. Tím ovlivňují kvantitu vody v povodí. Lidská 

činnost se však také promítá do kvality vody, která se s rostoucí průmyslovou 

výstavbou a intenzifikací zemědělství zhoršuje. (Sommer 1981) 

Spolu s intenzivní činností v zemědělství vznikaly odvodňovací nebo naopak 

závlahové systémy. S cílem dosáhnout co možná největších výnosů docházelo 

k používání umělých hnojiv, rozorávání mezí a na obhospodařování vzniklých velkých 

lánů se začaly používat těžké stroje, které svou vahou značně mění půdní podmínky. 

(Pokorná, Zábranská 2008) 

Velký vliv na množství zadržené vody v povodí i kvalitu odtékající vody má způsob 

obhospodařování pozemků. Voda ze srážek, která se po spadnutí na povrch ihned 

neinfiltruje, odtéká po svahu níže do povodí. Na povrchu svahu bývají prohlubně, 

v nichž se tato voda akumuluje. Díky této akumulaci se může voda do půdy vsakovat 

delší dobu a část se účastní také výparu, tím se sníží množství vody odtékající 

do vodního toku. Tyto prohlubně bývají rozrušovány orbou a vznikají brázdy. 

(Hrádek, Kuřík 2008) Je-li orba prováděna po spádu svahu, podporuje prudký 

povrchový odtok, který nejenže odvede vodu rychleji pryč, ale také podporuje vodní 

erozi. Pokud orba probíhá po vrstevnicích, má pro zadržení vody veliký přínos díky 

poměrně velké akumulační kapacitě. (Němec 1965) Pro představu rozdílu mezi 

akumulací vody na povrhu s brázdami po vrstevnicích nebo bez nich, jsou průměrné 

orientační hodnoty množství zadržené vody v závislosti na různých sklonech terénu 

uvedeny v Tab. 2. Jelikož odhad konkrétních hodnot bývá obtížný, bývá tato hodnota 

v empirických vzorcích nahrazována hodnotou stanovenou na základě využívání 

a způsobu obhospodařování pozemku. (Hrádek, Kuřík 2008) V některých případech, 

zejména u těžkých půd, by však orbou po vrstevnici mohlo docházet k zamokření 
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půdy. Orba se zde proto provádí s mírným odklonem od vrstevnic, aby zachycená 

voda, která se neinfiltruje ani neodpaří, mohla odtékat v mírně skloněné brázdě. 

(Němec 1965) 

 

Tab. 2 Poměrné hodnoty akumulace v povrchových depresích (Hrádek, Kuřík 2008) 

Sklon povrchu [%] 
Akumulace [mm] 

Povrch bez brázd Povrch s brázdami po vrstevnici 

0 5 60 

6 2 40 

12 1,5 20 

16 1 15 

20 - 10 

24 - 5 

 

Velký význam mají i nádrže, ať už jimi tok protéká či nikoliv, nebo jsou přírodní 

či vznikly uměle. Jejich přínos spočívá ve velkém množství vody, které se v nich 

akumuluje a velké ploše umožňující výpar. Díky nádržím jsou průtoky v tocích 

pod nimi vyrovnanější. Největším přínosem bývají zejména během povodní, 

kdy pomáhají transformací povodňových průtoků snížit kulminační průtok 

a prodloužit základnu povodňové vlny. (Němec 1965) Kolem nádrží také bývá 

specifické mikroklima a v okolí velkých nádrží dochází dokonce např. ke změnám 

teplotních a vlhkostních poměrů. Podobně jako u lesů i pro nádrže platí, že záleží 

na jejich umístění v rámci povodí. Jsou-li nádrže umístěny blíže uzávěrovému profilu, 

mají možnost regulovat odtok z větší části povodí. (Pokorná, Zábranská 2008) 

Na rozdíl od nádrží, bažiny působí na odtok spíše negativně a toky pod nimi se 

vyznačují značnou nevyrovnaností. Bažiny v období sucha zadržují velké množství 

vody, které jen velmi zvolna uvolňují, a to především výparem. Odtokový součinitel 

bažin je tedy v období nedostatku vody nízký. Naopak je tomu v období nadbytku 

vody, kdy je součinitel odtoku vysoký. Je to způsobeno tím, že bažina po svém 

nasycení již nezvládne pojmout další vodu, nově přitékající voda po jejím povrchu 

takřka všechna steče. (Kemel 1996) 
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Kromě antropogenních úprav prováděných v povodí, jsou odtokové poměry ovlivněny 

zhoršující se kvalitou ovzduší. Hlavním přirozeným zdrojem vody jsou v našich 

podmínkách srážky, které ovšem v důsledku průmyslových exhalací mění 

své chemické vlastnosti (kyselé deště) a dochází tak k poškozování lesních porostů 

a vegetace. (Hrádek, Kuřík 2008) Zejména v oblastech, kde dochází k odlesňování, 

je pak nutné očekávat častější průtoky s větší kulminací. To následně klade požadavek 

na nové posouzení vodohospodářských objektů a jejich případné nahrazení novými 

(více kapacitními), pokud nebudou schopné hydraulicky bezpečně převést očekávané 

zvýšené průtoky. (Pokorná, Zábranská 2008) 

3.1.5 Klimatičtí činitelé povrchového odtoku 

Na povrchovém odtoku se z klimatických činitelů účastní nejvíce srážky. 

Zanedbatelný však není ani vliv výparu, na jehož velikosti se podílí několik dalších 

klimatických faktorů. S výparem velmi úzce souvisí například teplota vzduchu i půdy, 

vlhkost vzduchu spolu se sytostním doplňkem, směr a rychlost větru a tlak vzduchu. 

(Němec 1965) 

Atmosférické srážky  

Ve vzduchu obsažené vodní páry kondenzují a stávají se z nich atmosférické srážky 

neboli hydrometeory. Podle skupenství srážky dělíme na kapalné a pevné. Mezi 

kapalné srážky se řadí ovlhnutí, rosa, mžení, déšť apod., jako pevné srážky se pak 

označují například sníh, kroupy, zmrzlý déšť, jinovatka a námraza. (Sommer 1981) 

V závislosti na místě a způsobu vzniku lze srážky rozdělit na vertikální a horizontální. 

Vertikální srážky vznikají ve volné atmosféře a zemský povrch dopadají ve formě 

deště, sněhu, krup, zmrzlého deště apod. Horizontální srážky naopak vznikají 

kondenzací na povrchu země, rostlin, předmětů atd. a řadí se mezi ně např. rosa, 

jinovatka nebo ledovka. (Kemel, Kolář 1980) V horizontálních srážkách je však 

obsažené výrazně menší množství vody než ve srážkách vertikálních, proto se 

horizontální srážky uvažují pouze ve zvláštních případech např. suchých oblastech 

nebo v zemědělství. (Hubačíková 2002) 

Množství srážek spadlých na povodí značně ovlivňuje povrchový odtok, a je proto 

jedním z hlavních prvků hydrologické bilance, kde se zpravidla vyjadřuje ve formě 

srážkové výšky. Kromě druhu a celkového množství srážek je důležité i jejich plošné 

rozložení a u kapalných srážek také doba trvání a jejich časový průběh. (Nypl 1986) 
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V dané oblasti lze plošné rozložení srážek znázornit izohyetami, které spojují místa 

se stejným srážkovým úhrnem. Srážkový úhrn je pro sestrojení izohyet určován 

pro všechny uvažované stanice jako průměr z dlouhodobých pozorování prováděných 

ve stejném období. (Pokorná, Zábranská 2008) Podle doby trvání se deště dělí 

na krátkodobé a dlouhodobé. Krátkodobé deště se vyznačují vysokou intenzitou 

a krátkou dobou trvání. Většinou se vyskytují po denním teplotním maximu, které 

vysokým výparem dostatečně podpořilo vývoj bouřkové oblačnosti. Krátkodobé deště 

mohou na tocích s menším povodím způsobit povodně. Naopak dlouhodobé deště 

povodněmi ohrožují toky s velkým povodím. Vyznačují se sice menší intenzitou, 

ale jejich trvání je delší a obvykle zasahují rozsáhlá území. (Hrádek, Kuřík 2008) 

Intenzita deště popisuje vztah mezi srážkovou výškou a časem, za který tato srážka 

spadla a obvykle se uvádí v mm za časovou jednotku. (Dub et al. 1969) 

Výpar 

Výpar zásobuje atmosféru vodou, která se odpařuje jak z volné hladiny, sněhu či ledu, 

tak i z půdy nebo z povrchu rostlin. Mimo vody zachycené na povrchu rostlin se 

výparu účastní také voda obsažená v pórech rostlin tzv. transpirací. Jelikož odlišit 

transpiraci od výparu z povrchu rostlin či půdy je problematické, bývá tento výpar 

souhrnně označován jako evapotranspirace. (Sommer 1981) Zvyšováním teploty vody 

se zvyšuje také kinetická energie molekul vody, díky které jsou schopny překonat 

soudržnost se zbytkem kapaliny, a dostávají se do atmosféry. Část těchto molekul se 

po srážce s molekulami již v atmosféře obsaženými vrací do původního prostředí. 

Velikost výparu je pak dána rozdílem těchto množství. Pokud se molekuly uvolňují 

z pevné fáze (sníh, led) rovnou do plynné fáze, označuje se tento proces jako 

sublimace. (Pokorná, Zábranská 2008) U výparu z půdy je velikost výparu také závislá 

na vlastnostech půdy, kde vlhkost závisí nejen na vsáklých srážkách, ale také na vodě 

vzlínající z hladiny podzemních vod. Zrnitost pak ovlivňuje nejen schopnost infiltrace 

a vzlínavosti, ale i velikost plochy umožňující výpar. Množství odpařené vody se 

v hydrologii většinou udává ve formě výšky infiltrace v mm, nebo jako intenzita 

výparu v mm za časovou jednotku. (Nypl 1986) 
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3.1.6 Říční síť v povodí 

Povodí lze rozdělit na menší území označované jako dílčí povodí. Jedná se o oblast, 

ze které sítí vodních toků odtéká veškerý povrchový odtok do určitého místa vodního 

toku (obvykle jezero nebo soutok řek). Pro oblast, ze které se povrchový odtok vlévá 

do moře, se používá označení úmoří. (Kemel 1994) Hlavní tok spolu se svými přítoky 

tvoří říční soustavu, ve které jsou toky označené řádem toku v závislosti na počtu 

posloupností, ve které se tok vlévá do moře (Obr. 5 a). Řád toku se označuje pomocí 

římských číslic, přičemž tok I. řádu se vlévá do moře a jeho přítoky jsou toky II. řádu, 

přítok toku II. řádu je tok III. řádu atd. (Sommer 1981) V rámci povodí se toky řadí 

(označují) podle hydrologického pořadí. Hydrologické pořadí se určuje směrem 

od pramene po proudu a 

od toků nižšího řádu k vyššímu 

(Obr. 5 b). Hydrologické 

pořadí bývá využíváno pro 

členění hydrologických údajů 

pro toky a jejich přítoky. 

(Hrádek, Kuřík 2008) 

Uspořádání říční sítě značně ovlivňuje tvar hydrogramu 

a velikost kulminačního průtoku. Podle postavení přítoků vůči 

hlavnímu toku se hovoří o stromkovité, perovité či vějířovité 

soustavě. (Hubačíková 2002) Při stromkovitém uspořádání 

říční sítě vedou přítoky hlavního toku podružnými údolími 

a svírají s hlavním tokem ostrý úhel. Stromkovitá soustava 

(Obr. 6 b) může být pravidelná, kdy se přítoky z obou stran 

pravidelně střídají, v opačném případě se jedná o nesymetrické 

stromkovité uspořádání. (Kemel 1996) Perovitá soustava se 

vyznačuje přítoky, které protékají paralelními údolími, a jejich 

napojení na hlavní tok je téměř kolmé. Vějířovitá soustava 

(Obr. 6 a) je nebezpečná z hlediska vzniku velkých, škodlivých 

povodní. Tento typ uspořádání se vyznačuje soutokem několika 

toků v jednom místě, přičemž tyto toky jsou stejného řádu a 

mají přibližně stejnou délku. S tím je spojená i podobná 

Obr. 6 Uspořádání říční 

sítě: a) vějířovité, 

b) stromkovité (Pokorná, 

Zábranská 2008) 

Obr. 5 Řád povodí (a), hydrologické pořadí (b) (Hrádek, Kuřík 

2008) 
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doběhová doba jednotlivých toků. Důsledkem může být vznik extrémně velkých 

povodní. (Pokorná, Zábranská 2008) 

Říční síť v povodí je také charakterizována hustotou říční sítě (5), která udává poměr 

mezi celkovou délkou všech toků v povodí (∑𝐿𝑇) a plochou povodí (F). 

(Kemel, Kolář 1980) 

   

 
𝑟 =

∑𝐿𝑇
𝐹

 (5) 

   

Absolutní výšky dna toku se znázorňují podélným profilem. Na vodorovné ose je 

vynesena kilometráž od začátku toku až po uzávěrový profil a ve směru svislé osy jsou 

vyznačeny nadmořské výšky dna odpovídající jednotlivým staničením. Podélný profil 

se zpracovává kromě grafické podoby 

(znázorněné na Obr. 7) také v tabelární 

podobě. Průměrný sklon dna (𝐼) se určuje 

z maximální (𝐻𝑚𝑎𝑥) a minimální (𝐻𝑚𝑖𝑛) 

nadmořské výšky na povodí vztažené 

k délce údolí toku (L) pomocí vztahu (6). 

(Nypl 1986) 

   

 
𝐼 =

𝐻𝑚𝑎𝑥 − 𝐻𝑚𝑖𝑛
𝐿

 (6) 

   

 

3.2 Objekty na malých vodních tocích 

Objekty na malých vodních tocích slouží ke zvýšení stability koryta, umístění vodního 

proudu, zachycení a usazení splavenin nebo k jiným účelům. Podle využití objektů je 

lze rozdělit na vodohospodářské, komunikační a ostatní. (Křovák et al. 2014) Kromě 

objektů lze stabilitu koryta zvýšit také opevňováním. Opevňování se používá převážně 

k zabezpečení svahů příčného profilu před vymíláním. Opevnění dna se provádí pouze 

ve výjimečných případech, zejména při nutném navržení větších sklonů, v místě 

objektů nebo např. ve zvláště exponovaných polohách. (Jůva et al. 1984) 

Obr. 7 Podélný profil (Nypl 1986) 
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3.2.1 Příčné objekty zajišťující stabilitu dna 

Příčné objekty se budují napříč toku s korunou nade dnem nebo v jeho úrovni. Mezi tyto 

objekty patří pásy a prahy, stupně, skluzy a přehrážky. Jejich hlavním cílem je zajištění 

nivelety dna, úprava podélného sklonu a zachycení splavenin. (Kovář, Křovák 2002) 

Pásy se zapouštějí do dna i břehů. Založeny jsou hlouběji, než se očekává vymílání 

a vedou až do úrovně dna. Jejich cílem je rozdělení dna do kratších úseků. Poskytují oporu 

splaveninám a postupně se přirozeným vývojem mění na přepadové objekty. 

(Křovák et al. 2014) Nejčastěji jsou pásy zhotoveny z betonových, dřevěných, zděných 

či drátokamenných konstrukcí, nebo z kamenné rovnaniny. (Novák 1998) 

Prahy slouží k úpravě podélného sklonu a zajištění nivelety dna proti hloubkové erozi. 

Jejich výška nepřesahuje 0,3 m a nepřerušují břehové linie. Pod prahy je zapotřebí opevnit 

dopadiště kamením, dřevem nebo klestem. Pro zhotovení prahů se používají stejné 

materiály, jako v případě pásů. (Mareš 1988) 

Stupně jsou přelivné objekty vyšší než 0,3 m s korunou ve výšce upravovaného horního 

koryta. Konstrukce se upevňuje buď na dostatečně únosné horninové podloží, nebo 

do zeminy. Při navrhování výšky stupně se volí spíše nižší hodnoty (obvykle 0,4 – 0,6 m) 

aby zůstala zachována průchodnost pro ryby. Ke zhotovení stupňů lze opět využít stejné 

materiály pro prahy a pásy. (Křovák et al. 2014) 

Skluzy jsou z hydraulického hlediska velmi vhodné při opevňování koryta o sklonu 1:5 

až 1:10. Jejich cílem je snížení kinetické energie. Voda proudí po drsné skluzové ploše 

a neodděluje se od ní. (Kovář, Křovák 2002) Stavebně jsou skluzy méně náročné 

než stupně a doporučují se také z ekologického hlediska, jelikož svou konstrukčně 

jednoduchou úpravou pouze modifikují přirozeně vytvářené dno malého toku. 

(Jůva et al. 1984) 

Přehrážky jsou objekty zhotovené nad úrovní dna, přičemž vzniklý zdržný prostor 

nad objektem slouží k zachycování splavenin. V závislosti na účelu se přehrážky dělí 

na retenční a konsolidační. Retenční přehrážky mají za účel zastavit přínos splavenin 

do nižší části toku. Cílem konsolidační přehrážky je zamezení dalšího zahlubování koryta. 

Mají zachytit velké nánosy splavenin a poskytnout oporu podemletým nebo sesunutým 

svahům. (Kovář, Křovák 2002) 
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3.2.2 Soustřeďovací a usměrňovací objekty 

Soustřeďovací a usměrňovací objekty mají za cíl usměrnit proudnici toku na širokých 

štěrkovištích nebo ochránit břehy u směrově nevyrovnaného koryta. Využívá se přitom 

vlastní energie vody, která zajišťuje vymílání a zanášení koryta v souladu s potřebami 

úpravy. (Pretl, Říha 1983) Tyto objekty mohou být podélné i příčné a k jejich stavbě 

se nejčastěji používají vhodné místní materiály bez nároku na vodotěsnost a zavazují 

se do břehů na dostatečnou hloubku, aby odolaly návrhovým průtokům. 

(Kovář, Křovák 2002)  

Příčné stavby vybíhají buď kolmo, nebo šikmo z břehů a končí na úrovni budoucí 

břehové linie. Umisťují se k jednomu břehu, mají-li zabránit jeho podemílání. 

Pokud je cílem soustředění proudu do jednoho směru a vytvoření nového koryta, 

pak se umístí po obou stranách koryta. (Krešl 1983) V prostoru mezi příčnými 

stavbami se snižuje průtočná rychlost, proto má materiál dopravovaný vodním 

proudem možnost se zde usazovat a postupně tento prostor zanášet. (Pretl, Říha 1983) 

Podélné soustřeďovací stavby se vytvářejí po délce toku. Představují nové břehy 

navrženého koryta a soustřeďují protékající vodu do užšího profilu. Výška 

soustřeďovacích objektů se určuje v závislosti na průtoku, při kterém nastává pohyb 

splavenin. Naplavování materiálu do prostoru mezi podélnou stavbou a původním 

břehem bývá podpořeno vybudováním příčných staveb zvaných traverzy. 

(Pretl, Říha 1983) 

3.2.3 Ostatní objekty 

Mezi ostatní objekty patří vyústění otevřených i trubních přítoků, křížení 

s inženýrskými sítěmi, odběry vody, vodoměrná zařízení, malé vodní elektrárny, rybí 

přechody, brody, schody atd. Nejdůležitější objekty z hlediska návrhových průtoků 

jsou však mosty, propustky a lávky. Jejich profily se při povodňových průtocích často 

ucpávají, což bývá zdrojem havárií. (Křovák et al. 2014) 

Mosty slouží k překlenutí vodního toku. Mosty by se měly zřizovat v rovných úsecích 

vodního toku tak, aby jejich konstrukce nezasahovala do průtočného profilu. Je-li 

to možné, měl by být most kolmý k ose toku. V opačném případě se doporučuje 

křížení komunikace a vodního toku v úhlu minimálně 60°. Při navrhování mostů je 

potřeba zohlednit návrhový povodňový průtok daný normou, který nedosáhne spodní 

mostové hrany s danou rezervou. (Jůva et al. 1984) Propustek je označení mostního 
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objektu s kolmou světlostí mostního otvoru do 2 m. těchto otvorů může být vedle sebe 

i více a zpravidla mívají kruhový, tlamovitý, vejčitý, elipsovitý, čtvercový nebo 

obdélníkový tvar. Lávka je mostní objekt určen pro pěší sloužící chodcům nebo je 

součástí mostu, sloužící revizním a jiným účelům. (MD 2016) 

3.2.4 Opevnění koryta 

Opevnění koryta musí mít odpovídající odolnost proti působení vodního proudu, proto 

se druh opevnění a jeho velikost volí na základě nevymílací střední průřezové rychlosti 

nebo kritického tangenciálního napětí. Opevnění koryta se skládá z opevnění dna 

a břehů. (Kovář, Křovák 2002) Podle typu použitých materiálů lze opevnění rozdělit 

na vegetační, nevegetační a kombinované. Z biologických i technickoekonomických 

důvodů se upřednostňuje opevnění vegetační, případně kombinované. (Mareš 1988) 

Dno se opevňuje po celé šířce pouze, pokud je tato varianta hospodárnější oproti 

úpravě stabilního sklonu dna. Částečné opevnění se provádí v nejvíce namáhaných 

místech, jako jsou konkávní strany oblouků, paty svahů, a místa, kde lze očekávat 

vytváření výmolů. (Křovák et al. 2014) Pro opevňování dna toku se používají pohozy, 

štětování, dlažba z lomového kamene, betonové dlažby, záhozy a stabilizační prahy. 

(Mareš 1988) 

Opevnění břehů má za cíl zajistit jejich odolnost proti působení vody za návrhového 

průtoku. Při opevnění břehů se upřednostňuje vegetační druh opevnění jako je 

například osetí, drnování, osazování vrbovými řízky, haťové povázky, válečky a válce, 

haťoštěrkové válce, zápletové plůtky a vrbové krytiny. V zastavěných oblastech 

a ve velmi sklonitých korytech bývají větší požadavky na odolnost, proto se 

zde používají nevegetační druhy opevnění. Mezi nevegetační opevnění patří kamenná 

dlažba, kamenný zához, kamenná rovnanina, drátokamenné opevnění, srubové stěny 

a opěrné zdi. Pokud je to ale možné, upřednostňuje se před nevegetačním opevněním 

zvolit opevnění kombinované. Odolnost obou druhů opevnění je stejná, ale díky 

vegetačním prvkům, má kombinované opevnění příznivější vliv na přírodní prostředí. 

Takovým opevněním může být oživený kamenný zához, oživená kamenná rovnanina 

či polovegetační tvárnice. (Kovář, Křovák 2002) 
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3.3 Povodně 

Povodní se rozumí hydrologický jev, během kterého hladina toku přechodně stoupá 

nad úroveň břehů, zaplavuje se území mimo koryto vodního toku a mohou vznikat 

značné škody. (Říha 2005) Povodní se také označuje stav, kdy voda způsobuje škody, 

protože nemá možnost dostatečného přirozeného odtoku. Povodně vznikají z různých 

příčin. Mohou být přirozené (dešťové, sněhové, smíšené, ledové), vzniklé jako 

následek poruchy na vodním díle, která vedla k havárii (protržení) nebo vyžadovala 

nouzové řešení kritické situace (zvláštní povodeň). (ČSN 750110, 

Zákon č. 254/2001 Sb.) 

Vodní zákon označuje za nebezpečí povodně stoupající tendenci vodních stavů, které 

již dosáhly stanoveného limitu, déletrvající či intenzivní srážky, předpověď náhlého 

tání či nebezpečný výskyt ledových jevů. Dále pak považuje za riziko vzniku povodně 

mimořádné situace na vodních dílech, kde hrozí nebezpečí poruchy. Začátek povodně 

je pak stanoven na okamžik, kdy je vyhlášen druhý nebo třetí povodňový stupeň 

a konec nastává při odvolání třetího povodňového stupně, pokud není v tomto 

okamžiku vyhlášen druhý povodňový stupeň. V takovém případě by se za konec 

povodně uvažovalo až odvolání druhého stupně povodňové aktivity. 

 (Zákon č. 254/2001 Sb.) 

Protipovodňová ochrana je kombinace různých organizačních a technických opatření. 

Organizační opatření zahrnují síť povodňových orgánů s potřebnými pravomocemi, 

Hlásnou a předpovědní povodňovou službu, zákony a různá opatření. Jejich cílem je 

upravit lidské aktivity tak, aby povodňové škody byly co nejmenší. Technická opatření 

se snaží povodním zabránit nebo zmírnit jejich následky např. zásahy do krajiny 

zvyšující její retenci, úpravou koryt, ochrannými hrázemi, přehradními nádržemi 

či poldry. (ČHMÚ ©2018) 

3.3.1 Druhy povodní 

Zvláštní povodně mohou být kromě již zmíněné havárie vodních děl způsobené 

ucpáním koryta a následným protržením této bariéry. K ucpání profilu může dojít 

zanesením cestních propustků nebo mostních otvorů keři, stromy nebo jinými, 

proudem unášenými, předměty. Možnou příčinou vzniku zvláštní povodně je také 

přímo zřícení mostku nebo sesuv svahu koryta. Dalším případem, kdy dochází 
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ke zvláštní povodni, je zpětné vzdutí vyvolané napojením v ústí na tok s vyšším 

povodňovým stavem vody. (Slavík, Neruda 2007) 

Přirozené povodně jsou důsledkem aktivní hydrologické bilance, a tudíž patří 

k neodmyslitelným součástem hydrologického oběhu v krajině. Na území České 

republiky, lze rozdělit přirozené povodně do jednoho ze 4 hlavních typů. 

(Čamrová, Doležal 2006) 

Letní povodně z krátkodobých přívalových dešťů mohou způsobit tzv. bleskové 

povodně. Vznikají převážně v létě, kdy jsou vhodné podmínky pro tvorbu bouřkové 

oblačnosti. Srážky z této oblačnosti bývají velmi intenzivní s krátkou dobou trvání a 

zasahují menší území. Velké množství vody nemusí půda stíhat infiltrovat, voda pak 

stéká po povrchu a může vést k rychlému vzestupu povodňové vlny. Následkem těchto 

povodní může být mimo značných materiálních škod, také ohrožení lidských životů 

a vznik velké vodní eroze. (Čamrová, Doležal 2006) 

Letní typ povodní z regionálních dešťů je spojován s atmosférickými frontami. 

Vznikají jako následek deště s menší intenzitou, ale dlouhou dobou trvání. Půda 

v povodí se postupně nasytí, takže není schopna další vodu již infiltrovat a ta odtéká 

po povrchu. Jelikož dochází k zasažení srážkami na rozsáhlejším území, dochází 

k zasažení povodní na všech tocích v postižené oblasti a postupu povodní dále 

po směru proudu. Tyto povodně tedy ohrožují zejména střední a velká povodí. (Slavík, 

Neruda 2007) 

Zimní a jarní typ povodní z tání sněhu je způsoben dlouhodobějším oteplením 

vzduchu nad 0°C čímž začne docházet k odtávání sněhové pokrývky. Množství vody 

ve sněhové pokrývce je dáno její výškou a vodní hladinou. Míru a rychlost odtávání 

ovlivňuje řada faktorů, např. tepelný stav půdy, míra oteplení, vlhkost vzduchu, 

nadmořská výška nebo expozice svahu. Velký vliv mají také dešťové srážky, které 

jinak pozvolný vývoj povodňové vlny urychlují a zvyšují odtok. (Čamrová, Doležal 

2006) 

Zimní a jarní typ ledových povodní je způsoben sníženou průtočností koryta toku 

v závislosti na ledových útvarech na toku. Ledová vrstva pokrývající hladinu se láme 

a ledové kry jsou unášeny proudem. V profilech s nižší průtočností nebo v místech, 

kde je ledová vrstva zachována, dochází k ledovým zácpám. Následkem pak je 
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vzdouvání vodní hladiny a velmi nebezpečné povodňové stavy při jejich protržení. 

(Slavík, Neruda 2007)  

3.3.2 Povodňová opatření 

Povodňová opatření mají organizační charakter a dají se rozdělit na přípravná opatření, 

opatření prováděná při nebezpečí povodně, za povodně a opatření prováděná 

po povodni. (Zákon č. 254/2001 Sb.) 

Přípravná opatření mají zajistit adekvátní a včasné reakce v případě povodní. Mohou 

mít povahu: 

• Plánování – povodňové plány a prohlídky, vytváření hmotných povodňových 

rezerv, organizační a technická příprava 

• definování nebezpečí a ohrožených míst – vymezení směrodatných limitů 

stupňů povodňové aktivity a stanovení záplavových území 

• školení členů zasahujících složek – příprava předpovědní a hlásné povodňové 

služby, příprava účastníků povodňové ochrany (Zákon č. 254/2001 Sb.) 

Opatření při nebezpečí povodně a za povodně mají zajistit včasné varování 

obyvatelstva, vyklizení záplavových území a povodňové záchranné práce. Dále 

pak zahrnují činnost povodňové služby, řízené ovlivňování odtokových poměrů nebo 

zabezpečení náhradních funkcí a služeb v území zasaženém povodní. 

(Zákon č. 254/2001 Sb.) 

Po povodni je potřeba provést evidenční a dokumentační práce. Mezi další prvky 

opatření po povodni patří vyhodnocení povodňové situace a vzniklých povodňových 

škod, včetně jejich odstranění a následná obnova území po povodni. 

(Zákon č. 254/2001 Sb.) 

3.3.3 Povodňové zabezpečovací práce 

Na rozdíl od povodňových opatření mají povodňové zabezpečovací práce technický 

charakter. Provádí se při se při nebezpečí povodně a za povodně, jejich cílem je 

zmírnění průběhu povodně a jích škodlivých následků. Hlavními typy 

zabezpečovacích prací je zprůchodnění vodních toků a profilů objektů, opatření proti 

přelití a protržení hrází, instalace protipovodňových zábran a opatření vedoucí 

ke stabilizaci území, snížení znečišťování vody a zejména u kanalizací o opatření 

proti zpětnému vzdutí vody. (Zákon č. 254/2001 Sb.) 
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3.3.4 Stupně povodňové aktivity 

Stupně povodňové aktivity (SPA – Obr. 8) udávají míru ohrožení povodní. 

Jsou udávány ve formě směrodatných limitů, které většinou představují vodní stavy 

nebo průtoky v hlásných profilech. Tyto limity navrhují správci toku a poté je schvalují 

krajské úřady příp. Ministerstvo životního prostředí ČR. Hodnoty limitů pro 2. a 3. 

povodňový stupeň jsou ovšem pouze orientační a povodňové úřady při jejich 

vyhlašování a odvolávání mohou přihlédnout k dalším faktorům. (ČHMÚ ©2018) 

1. SPA (stav bdělosti) – nastává, pokud 

průtok dosahuje nadprůměrných hodnot, 

ale voda zatím zůstává v korytě. 

Je signálem pro přípravu na povodeň 

zahrnující např. kontrolu okolí vodního 

toku a propustků. (ČHMÚ ©2018) 

2. SPA (stav pohotovosti) – při druhém 

povodňovém stupni se již voda vylévá 

z koryt, ale nezpůsobuje žádné větší škody. 

Většinou se jedná o zaplavení pastvin, luk 

nebo dalších příbřežní vegetace. V této 

chvíli povodňové orgány zahajují úkony 

pro zmírnění povodní stanovené 

v povodňovém plánu. (ČHMÚ ©2018) 

3. SPA (stav ohrožení) – již dochází k zaplavování budov, komunikací apod. 

Podle povodňového plánu se provádí evakuace a zabezpečovací či záchranné 

práce. (ČHMÚ ©2018) 

3.3.5 Povodňové plány 

Povodňové plány mají tři části – věcnou, organizační a grafickou. Stanovují se v nich 

směrodatné limity stupňů povodňové aktivity. Udávají, jakým způsobem mají být 

zajištěny včasné a spolehlivé informace o vývoji povodně, jak lze ovlivnit odtokový 

režim, organizaci a přípravu zabezpečovacích prací. Dále vymezují potřebné úkony 

při jednotlivých stupních povodňové aktivity a zajištění základních funkcí v objektech 

a v území. (Zákon č. 254/2001 Sb.) 

Obr. 8 Stupně povodňové aktivity 

(ČHMÚ ©2018) 
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3.3.6 Záplavová území 

Záplavová území vymezují území zaplavovaná vodou při výskytu přirozené povodně. 

Jsou ohraničena záplavovou čarou, která je průsečnicí terénu a hladiny vody během 

povodní. Území, ve kterém se nachází zástavba a během povodní je zde bezprostředně 

ohroženo zdraví, život a majetek lidí, je označováno jako aktivní zóna záplavového 

území. Inundačním územím se pak rozumí území zaplavované při překročení kapacity 

koryta toku. (MŽP 2002) Rozsah záplavového území a vymezení aktivní zóny 

stanovuje vodoprávní úřad na základě návrhu správce toku formou opatření obecné 

povahy. Tímto opatřením je také zákaz umisťování, povolování a provádění staveb 

v aktivní zóně záplavového území. Výjimku tvoří pouze vodní díla, která mají za účel 

situaci na toku zlepšovat. Dále se v aktivní zóně nesmí provádět činnosti mající 

negativní vliv na odtokové poměry např.: těžba nerostů a zemin, skladování 

odplaveného materiálu, zřizování oplocení nebo jiných překážek. Také platí zákaz 

zřizování kempů, táborů nebo jiného dočasného ubytovacího zařízení v aktivní zóně 

záplavového území. (Zákon č. 254/2001 Sb.) 

3.4 Matematické modely v hydrologii 

Matematické modelování hydrologických procesů má za cíl časově nebo  

časo-prostorově charakterizovat hydrologický režim modelovaného povodí nebo jeho 

částí. Matematické modely popisují simulované jevy na základ schematizace reálného 

prostředí a je tvořen matematickými vztahy a okrajovými podmínkami platnosti. 

(Bízek 2011) Modely jsou tvořeny vždy za určitým účelem a je potřeba třeba si 

uvědomit, že některé modely jsou sice užitečné a mohou být používány, ale přesto jsou 

všechny modely v podstatě nesprávné. Otázkou je pak vždy, jak moc musí být model 

špatný, aby se již nedal pro řešený problém použít. (Box, Draper 1987) Při konstrukci 

modelu je proto vždy třeba hledat vhodný kompromis mezi třemi základními rysy: 

• Obecnost – použitelnost modelu pro podobné nebo analogické procesy 

či objekty. 

• Realistický popis – zjednodušení musí být jen do té míry, aby model zůstal 

dostatečným popisem dané části reality. 

• Shoda – výstupy modelu a pozorované chování dané části reality musí být 

v kvantifikovatelné shodě. 
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Příkladem časté varianty kompromisu jsou speciální modely, u nich bývá potlačena 

obecnost, platí pouze pro specifický účel. Na druhou stranu je u nich dosahováno 

poměrně realistického popisu a přesných výsledků. (Levins 1968) Přestože je 

požadovaný dobrý realistický popis a přesnost, nemělo by u modelů docházet 

k jejich přeparametrizování. Model má být co nejjednodušší a další parametr má být 

přidáván pouze pokud existuje silný důkaz, že je pro daný problém nenulový. 

Přílišným množstvím parametrů, klesá predikční síla modelu. Příkladem může být 

víceparametrová regrese, kde jsou hodnoty získávány nelineární interpolací. Polynom 

sice dobře přiléhá ke kalibračním datům, ale nelze ho již se stejnou přesností použít 

pro predikci (extrapolaci) nebo simulaci, tedy interpolaci s pozměněnými hodnotami 

nezávislých proměnných. (Bízek 2011) 

Chyby v matematickém modelování lze rozdělit do čtyř kategorií: 

1. Neadekvátnost modelu – příkladem takové chyby je nevhodnost řešení 

matematických vztahů, přílišná složitosti modelu, chybné nastavení nebo 

chybějících okrajové podmínky apod. 

2. Chyba vstupních dat – tyto chyby, ať již systematické nebo náhodné, vedou 

k nesprávné kalibraci modelu 

3. Numerické chyby při výpočtech – chyby této kategorie mohou vzniknout 

při numerickém výpočtu funkce aproximací pomocí řad (např. numerický 

výpočet funkce sinus pomocí Taylerovy řady), iterativními a interpolačními 

procesy, metodou integrace diferenciálních rovnic apod. 

4. Výpočetní chyby – do této kategorie spadají také programátorské chyby 

při práci s různými datovými typy, nesprávným řízením výpočetního 

postupu atd. (Neumann, Goldstine 1947) 

3.4.1 Klasifikace modelů 

Matematických modelů v hydrologii popisujících jednotlivé komponenty  

srážko-odtokového procesu je celá řada. Na základě podobnosti nebo odlišnosti 

přístupu k řešené problematice lze hydrologické modely začlenit do klasifikace podle 

WMO (World Meteorological organisation). (Becker, Serban 1990) Rozčlenění 

modelů je důležité zejména pro uživatele, kterým by měla usnadnit orientaci ve velkém 

množství modelů a pomoci jim s volbou vhodného modelu pro řešení konkrétní 

problematiky. (Jeníček 2007) Tato klasifikace vychází z několika principů: 
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• Účel použití modelu 

• Typ simulovaného systému 

• Zohlednění modelovaného hydrologického procesu 

• Kauzalita 

• Míra diskretizace (časová a prostorová) 

Podle účelu použití se modely dělí do 3 skupin:  

• Modely pro operativní hydrologii - pro tyto modely jsou vstupními daty mimo 

stavové veličiny také údaje okamžikové, získané z automatických 

meteorologických stanic či radarů. Cílem je rychlé zpracování těchto dat a 

vytvoření krátkodobé předpovědi vodního stavu nebo průtoku v daném profilu. 

Více těchto specializovaných modulů společně s dalšími programovými 

prostředky pro sběr a zpracování dat v praxi tvoří předpovědní systém  

(FFS – Flood Forecast System). 

• Modely využívané pro návrhovou a projekční činnost v oblasti vodního 

hospodářství – jedná se o dlouhodobější řešení protipovodňové ochrany 

(např. stavba poldrů, přehrad a další hydromeliorační či hydrotechnická 

opatření). Dále tato skupina zahrnuje modely užitečné při řešení nejrůznějších 

technických staveb. Tyto modely často slouží k simulaci variant s různými 

vstupními podmínkami. 

• Modely využívané ve výzkumu - tento způsob užití modelu umožňuje jeho 

další vývoj. Přínosem je výzkum a přesnější popis jednotlivých komponent 

srážko-odtokového procesu na základě přesných experimentálních měření. 

Častým využitím výstupů z modelu je jejich použití jako vstupních veličin 

dalších modelů. (Bízek 2011) 

Z hlediska typu systému se rozlišují modely elementární a komplexní. Elementární 

systém je tvořen tzv. hydrotopem – jednotkou s konstantními charakteristikami (např. 

malá odtoková plocha, zvodnělá vrstva, jezero nebo nádrž). Druhý případ je tvořen 

velkými odtokovými plochami, povodí, nebo systémem říčních sítí nádrží a jezer. 

(Daňhelka et al. 2002) 

Asi nejčastěji používaným dělením modelů v hydrologii je podle jejich kauzality. 

Ta je vyjádřena vztahem příčina – důsledek a rozděluje modely na deterministické 
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a stochastické. Deterministické modely popisují výstupy (závisle proměnné) 

na základě funkční závislosti vůči vstupním hodnotám (nezávisle proměnné). 

Deterministické modely se od sebe liší svojí strukturou, fyzikálním přístupem, 

časovou a prostorovou diskretizací. Stochastické modely vazbu mezi příčinou a 

následkem primárně neobsahují. Stochastické modely se dělí na pravděpodobnostní 

a modely generování časových řad. Na Obr. 9 je znázorněno rozdělení  

srážko-odtokových modelů do hlavních skupin. (Becker, Serban 1990) 

 

Obr. 9 Rozdělení srážko-odtokových modelů (Becker, Serban 1990) 

Modely mívají různou časovou diskretizaci podle způsobu použití. Pro bilanční 

modely je postačující délka výpočetního kroku delší, např. týden, měsíc. Při řešení 

operativní předpovědi, povodňové studie, modelování šíření znečištění nebo 

transportu plavenin či splavenin se běžně užívá hodinový až denní krok. Dalším 

možným dělením je podle časové kontinuity na modely kontinuální (delší i víceletá 

období) a epizodní (jen dílčí události – povodeň, hydrologické sucho). (Jeníček 2007) 

Z pohledu na prostorovou diskretizaci se modely dělí na celistvé, distribuované a  

semi-distribuované. Celistvé (lumped) modely vztahují parametry charakterizující 

povodí (stavové veličiny i časové řady) k celému nebo dílčímu povodí. Distribuované 

modely naopak uvažují úvahu prostorovou variabilitu vstupních a následně 

i výstupních parametrů. Povodí je rozděleno sítí – gridem (čtvercovým nebo 
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trojúhelníkovým) na elementární odtokové plochy, kde je pro každé políčko gridu dána 

charakteristická hodnota parametru. Velikost gridu by však neměla překročit 1 km, 

kvůli zaručení platnosti řídících rovnic. Semi-distribuované modely pak spojují oba 

předchozí přístupy. Povodí je rozděleno gridem, ale hodnoty charakteristik jsou 

prostorově homogenní. (Becker, Serban 1990) 

Podle řešené problematiky se rozlišují modely srážko-odtokové, hydrodynamické, 

hydrologické bilance, transportu znečištění apod. (Clarke 1973) Mezi nejpoužívanější 

srážko-odtokové modely se řadí MIKE-SHE, HEC-HMS,  

SAC-SMA, SWAT, HBV, HYDROG, NASIM a SWIM. Hydrodynamikou se 

zabývají zejména modely skupiny MIKE, HEC-RAS, Hydrocheck, FAST2D a 

FESWMS. Hydrologickou bilanci řeší modely BILAN a WBCM. Transport 

sedimentů a erozi lze modelovat pomocí AnnAGNPS, SWAT, ErosionN, Erosion 3D 

a Flo 2D. (Jeníček 2006) 

3.4.2 Hydrodynamické modely 

Hydrodynamické modely řeší reálné fyzikální zákony vycházející ze zákonů 

zachování hmoty, energie a hybnosti. Jsou to převážně deterministické modely, které 

se snaží stochasticitu potlačit řešením parciálních diferenciálních rovnic. Přímé řešení 

diferenciálních rovnic je náročné, proto se výpočet provádí pomocí numerických 

metod. (Bardossy 2007) Hydrodynamické modely se většinou využívají pro predikci, 

ale občas jsou využity také k simulaci již skončených povodňových událostí 

např. způsobených havárií vodního díla. Vždy je důležité zvážit, jaká data máme 

k dispozici, velikost a strukturu povodí a na základě toho zvolit vhodný model a 

náročnost jeho struktury. (Bergström 1991) Přičemž platí, že se zvyšující se složitostí 

modelu roste nárok na vstupní data. (Jowett, Duncan 2012) Podle počtu dimenzí, 

ve kterých je problém řešen, lze modely na jednorozměrné (1D), dvourozměrné (2D) 

a příp. jejich kombinaci (1D/2D). (Barnard et al. 2007) 

Výhodou 1D modelů je relativní jednoduchost a malý nárok na vstupní data. Tyto 

modely popisují proudění pouze v jednom směru – udávají střední svislicovou rychlost 

a výšku hladiny. Schematizace řešeného území je provedena formou příčných profilů, 

mezi nimiž se předpokládá lineární průběh jak geometrických, tak i hydraulických 

parametrů. Dalšími vstupními daty jsou vhodně zvolené okrajové podmínky, stanovení 

drsností a vymezení neprůtočných oblastí. Dalšími důležitými vstupy jsou mapové a 
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kalibrační podklady a hydrotechnický popis objektů na toku. Hlavními 1D modely 

jsou HEC-RAS (podrobněji v kapitole 3.4.3), MIKE 11 (resp. MIKE HYDRO) a 

Hydrochek. (Balvín et al. 2009) 

MIKE HYDRO je nástupcem programu MIKE 11. Jedná se o jednorozměrný 

komplexní model říčních sítí, který pro otevřená koryta a inundační území řeší 

proudění, kvalitu vody a pohyb splavenin. (DHI ©2017a) Je vhodný pro předpovídání 

a modelování rizikové analýzy povodní, optimální řízení provozu nádrží, stanovování 

kvality vody. Zároveň je možné model propojit s dalšími modely ze skupiny MIKE a 

tím rozšířit možnost využití. (Bízek 2011) 

Hydrocheck je program pro řešení ustáleného nerovnoměrného proudění v otevřených 

korytech včetně objektů a řady návazných úloh. Na jeho vývoji se podílí Povodí Ohře 

a jeho předností je zaměření na zpracování aktivních zón a výkresové dokumentace 

v závislosti na české legislativě, jejíž změnám se dá model přizpůsobit na uživatelské 

úrovni. (Hydrosoft 2018) 

Modely 2D se používají, pokud je vypovídající hodnota 1D modelu pro danou 

problematiku nepostačující např. z důvodu morfologické složitosti toků, zátok nebo 

ústí řek. Jsou také vhodné při posuzování vlivu překážek na změnu proudového pole, 

za překážkami, v plavebních komorách apod. (Balvín et al. 2009) Proti 1D modelům 

jsou dvoudimenzionální modely náročnější na vstupní (zejména topografická) data. 

Výpočet je prováděn nad dvousměrnou výpočtovou sítí, která je rozprostřena na celé 

modelované oblasti. Přičemž v každém uzlu výpočetní sítě počítají výšku hladiny a 

rychlost proudění ve směru os (x, y). (Jowett, Duncan 2012) To vede na řešení 

soustavy parciálních diferenciálních rovnic, které jsou analyticky neřešitelné. Musí se 

tedy řešit numericky použitím metody konečných prvků, konečných objemů nebo 

konečných diferencí. Jelikož je složitost výpočtu pro 2D modely vyšší, je také kladen 

větší nárok na hardware počítače a přesnost výpočtů. (Steffler, Blackburn 2002) 

Nejpoužívanějšími 2D modely v ČR jsou HEC-RAS, MIKE 21C, FAST 2D a 

FESWMS. (Balvín et al. 2009) 

MIKE 21C od firmy DHI je speciální modul softwaru MIKE 21. Jeho výhodou je 

zakřivená výpočetní síť, díky které lze situaci řek lépe popsat. Jedná se o velmi 

komplexní dvoudimenzionální model, zaměřený především na morfologii řek a 

transport sedimentů. Často se používá k simulaci vlivu trubních přechodů, tunelů 
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a mostů na říční hydrauliku a morfologii, posuzování konstrukce jezů, přehrad, 

vlnolamů apod. a předpovídání sedimentace. (DHI ©2017b)  

FAST 2D je dvourozměrný model, který využívá zjednodušenou hydrauliku. Software 

je založen na indikaci depresí v záplavové ploše, jejichž hloubka je dána objemem 

vody, která do nich natéká, hladinou odtoku do sousedních depresí a hloubku vody 

v sousedních depresích. Díky tomu umožňuje simulaci záplav v řádu sekund či minut 

(až 1000x rychleji než tradiční 2D modely) a je vhodný pro využití zejména v případě 

potřeby rychlého posouzení povodňových škod (CH2M HILL 2015). 

FESWMS je 2D model vyvinutý pod záštitou Federální dálniční správy USA a 

zaměřující se zejména na modelování oblastí, ve kterých dochází ke křížení toku se 

silnicemi. Výhodou modelu je možnost řešení důležitých objektů jako jsou jezy, 

propustky, mosty apod. včetně tlakového proudění. (Aquaveo ©2018) 

Modely 3D se používají pokud je potřeba popsat tvarově složité prostředí. Příkladem 

použití může být obtékání břehových a středových podpěr mostů a propustků. 

Tyto modely umožňují zjistit překročení vymílací rychlosti a upozornit na potřebu 

opevnění břehů a dna koryta. (Balvín et al. 2009) 

Příkladem takového modelu může být MIKE 3, který se zabývá řešením 

hydrodynamiky, dynamiky sedimentů, kvality vody a ekologie. Model lze použít 

pro řešení problémů s advekčně–disperzním prouděním, ropných skvrn, pokročilé 

modelování kvality vody, pohyb sedimentů a dalších jevů. (DHI ©2016) 

3.4.3 HEC-RAS – 1D modely 

HEC-RAS je jedním z nejpoužívanějších softwarů ze skupiny HEC. Tyto softwary 

vyvíjí inženýři armády USA v hydrologickém inženýrském centru (Hydrologic 

Engineering Center) odkud pochází zkratka HEC. Označení RAS je pak zkratkou 

pro River Analysis System. HEC-RAS se tedy specializuje na analýzu říční sítě. 1D 

model, dovede na základě stejných geometrických dat a výpočetních postupů řešit čtyři 

jednorozměrné analýzy – ustálené proudění (Steady Flow Water Surface Profiles), 

neustálené proudění (Unsteady Flow Simulation), transport splavenin (Sediment 

Transport) a kvalitu vody (Water Quality Analysis). (Dyhouse et al. 2003)  
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Analýza ustáleného proudění  

Model umožňuje řešit říční i bystřinné proudění nebo jejich kombinaci a lze ho využít 

pro simulace na jednotlivých úsecích toku i celé sítě. Do výpočtu lze zahrnout také 

vliv různých překážek (objektů) na toku i v záplavové oblasti. Ustálené proudění je 

řešeno metodou po úsecích, tedy vždy jsou uvažovány dva sousední příčné profily. 

V profilech se počítá výška hladiny pro daný N-letý průtok na základě Bernoulliho 

rovnice (7). Při řešení průtoku mimo koryto je jiná hodnota součinitele drsnosti, proto 

je profil rozdělen na úseky se stejnými drsnostmi a v každé z nich je rychlost průtoku 

řešena pomocí Manningovi rovnice (9). (Brunner 2016b) 

   

 
𝑧2 + 𝑦2 +

𝛼2𝑣2
2

2𝑔
= 𝑧1 + 𝑦1 +

𝛼1𝑣1
2

2𝑔
+ ℎ𝑒  (7) 

 z … nadmořská výška dna koryta [m n. m.] 

y … výška hladiny v korytě [m] 

 … koeficientem kinetické energie [-] 

v … rychlost [m.s-1] 

g … gravitační zrychlení [m.s-2] 

ℎ𝑒 … ztráty energie [m], určené pomocí rovnice (8) 

 

   

 
ℎ𝑒 = 𝐿𝑆𝑓̅ + 𝐶 |

𝛼2𝑣2
2

2𝑔
−
𝛼1𝑣1

2

2𝑔
| (8) 

 L … vzdálenost profilů [m] 

𝑆𝑓̅ … střední hodnota ztráty energie třením [-] 

C … koeficient ztráty energie způsobené rozšířením / 

zúžením průtočného profilu [-] 

 

   

 
𝑣 =

1

𝑛
𝑅2/3 𝑖1/2 (9) 

 n … Manningův součinitel drsnosti [-] 

R … hydraulický poloměr [m] 

i … sklon dna [-] 
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Analýza neustáleného proudění 

Modul pro řešení neustáleného proudění obsahuje stejné komponenty jako modul 

ustáleného proudění, který je rozšířen o možnost řešení postupu povodňové vlny. Díky 

tomu je vhodný pro analýzu protržení hráze, přelití či protržení ochranných hrází, 

provoz přehrad, čerpací stanice apod. (Brunner 2016b) 

Analýza transportu sedimentů 

Tento modul simuluje transport sedimentů na základě jejich zrnitostních frakcí. 

Analýza je obvykle prováděna za středně dlouhé období (např. rok) nebo během 

jednotlivých povodňových událostí. Využití model nachází při řešení usazenin 

v nádržích, vyhodnocování samočistících schopností vodních toků při velkých 

povodních, odhadu vlivu odbahnění na rychlost usazování a předpovídání sedimentace 

v opevněných, umělých korytech. (Brunner 2016b) 

Analýza kvality vody 

Modul kvality vody umožňuje na základě explicitně řešené jednorozměrné  

konvekčně-difuzní rovnice podrobně analyzovat kvalitativní složky jako jsou řasy, 

rozpuštěný fosfor, rozpuštěný dusík, rozpuštěný kyslík a uhlíko-biologická spotřeba 

kyslíku. Dále lze modul využít k analýze tepoty vody či proudění tepla. (Brunner 

2016b) 

3.4.4 HEC-RAS – 2D modely 

Software HEC-RAS také umožňuje řešení 2D modelů, avšak pouze pro neustálené 

proudění. Výpočet vychází z řešení Navier-Stokesových rovnic, které popisují pohyb 

tekutin ve třech směrech. Pro modelování proudění v říčních korytech a povodní není 

nutné používat takto složitý model, proto i HEC-RAS používá zjednodušenou formu 

těchto rovnic. Zjednodušený model využívá rovnice proudění mělkých vod, kde 

se předpokládá nestlačitelný průtok, rovnoměrná hustota a hydrostatický tlak. Rovnice 

jsou zprůměrovány podle Reynoldse tak, aby turbulentní pohyb byl aproximován 

použitím turbulentní viskozity. Také se předpokládá, že vertikální délková stupnice je 

menší než vodorovné délkové stupnice. V důsledku toho je vertikální rychlost malá a 

tlak hydrostatický. (Brunner 2016b)  
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Zákon zachování hmotnosti 

Předpokládá-li se nestlačitelná kapalina, lze uvažovat zákon zachování hmotnosti 

ve tvaru (10) resp. jeho vektorovou formu (11), kde 𝑉 = (𝑢, 𝑣) je rychlostní vektor a 

𝑞 představuje přítok/odtok. 

   

 𝜕𝐻

𝜕𝑡
+
𝜕(ℎ𝑢)

𝜕𝑥
+
𝜕(ℎ𝑣)

𝜕𝑦
+ 𝑞 = 0 (10) 

   

 𝜕𝐻

𝜕𝑡
+ ∇ ∙ hV + 𝑞 = 0 (11) 

   

Integrací normálovým vektorem n a užitím Gaussovy věty se získá integrální forma 

rovnice (12), kde Ω je elementární objemový prvek, který je v programu HEC-RAS 

řešen metodou konečných objemů. (Brunner 2016b) 

   

 𝜕

𝜕𝑡
∭ 𝑑Ω

Ω

+∬ 𝑉 ∙ 𝑛𝑑𝑆
𝑆

+ 𝑄 = 0 (12) 

   

Zjednodušení schematizace povrchu je důležité, protože skutečný povrch je značně 

členitý a jeho popis velmi složitý. Dalším zjednodušením je rozdělení povrchu pomocí 

výpočetní sítě. Jednotlivé buňky představují elementy pro výpočet numerickými 

metodami. Pro takový element lze zapsat obecnou rovnici zákona o zachování 

hmotnosti ve tvaru (13), kde Ω je objem elementu a 𝐴𝑘 představuje obsah stran 

elementu.  

   

 Ω(𝐻𝑛+1) − Ω(𝐻𝑛)

Δ𝑡
+∑ 𝑉𝑘 ∙ 𝑛𝑘𝐴𝑘(𝐻) + 𝑄

𝑘
= 0 (13) 
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Zákon zachován hybnosti 

Vzhledem k předpokladu mělkých vod, lze zanedbat proudění ve svislém směru. Díky 

tomu je možné obecné rovnice zjednodušit. Dále je možné použít Bousinesquovo 

zjednodušení a uvažovat stejné hustoty kapaliny v celém objemu. Do výpočtů tak 

vstupuje pouze hydrostatický tlak. Dalším zjednodušením je zanedbání účinků vnější 

síly větru působícího na hladinu. Po zavedení těchto zjednodušení se počet  

Navier-Stokesových momentových rovnic sníží na dvě rovnice pro horizontální směry 

(14), které lze také zapsat ve vektorové formě (15). (Brunner 2016b) 

   

 𝜕𝑢

𝜕𝑡
+ 𝑢

𝜕𝑢

𝜕𝑥
+ 𝑣

𝜕𝑢

𝜕𝑦
= −𝑔

𝜕𝐻

𝜕𝑥
+ 𝑣𝑡 (

𝜕2𝑢

𝜕𝑥2
+
𝜕2𝑢

𝜕𝑦2
) − 𝑐𝑓𝑢 + 𝑓𝑣

𝜕𝑣

𝜕𝑡
+ 𝑢

𝜕𝑣

𝜕𝑥
+ 𝑣

𝜕𝑣

𝜕𝑦
= −𝑔

𝜕𝐻

𝜕𝑦
+ 𝑣𝑡 (

𝜕2𝑣

𝜕𝑥2
+
𝜕2𝑣

𝜕𝑦2
) − 𝑐𝑓𝑣 + 𝑓𝑢

 (14) 

   

 
𝜕𝑉

𝜕𝑡

⏞
1.

+ 𝑉 ∙ ∇𝑉⏞  
2.

⏟        
𝑃𝑟𝑣𝑘𝑦 𝑣𝑦𝑗𝑎𝑑ř𝑢𝑗í𝑐í

𝑧𝑟𝑦𝑐ℎ𝑙𝑒𝑛í

= −𝑔∇𝐻⏞
3.

+ 𝑣𝑡∇2𝑉⏞  
4.

− 𝑐𝑓𝑉⏞
5.

+ 𝑓𝑘 × 𝑉⏞    
6.

⏟                    
𝑃𝑜𝑝𝑖𝑠 𝑣𝑛𝑖𝑡ř𝑛í𝑐ℎ 𝑎 𝑣𝑛ě𝑗ší𝑐ℎ 𝑠𝑖𝑙
 𝑝𝑢𝑠𝑜𝑏í𝑐í𝑐ℎ 𝑛𝑎 𝑘𝑎𝑝𝑎𝑙𝑖𝑛𝑢

 
(15) 

 1. 
𝜕𝑉

𝜕𝑡
 … prvek neustáleného proudění 

2. 𝑉 ∙ ∇𝑉 … prvek konvektivního zrychlení 

3. 𝑔∇𝐻 … prvek hydrostatického tlaku 

4. 𝑣𝑡∇
2𝑉 … prvek turbulentní kinematické viskozity 

5. 𝑐𝑓𝑉 … prvek dnového tření 

6. 𝑓𝑘 × 𝑉 … prvek Coriolisovi síly 
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Difúzní rovnice 

Další možnou variantou výpočtu, kterou HEC-RAS umožňuje, je řešení pomocí 

difúzních vln. Zde je uvažováno, že pohyb kapaliny je způsoben působením zemské 

tíže a třením o dno. Rovnice zachování hmotnosti (11) tedy přechází do reakčně 

difúzní rovnice (16) a obecná rovnice pro element ve výpočetní síti lze převést 

do podoby (17). (Brunner 2016b) 

   

 𝜕𝐻

𝜕𝑡
− ∇ ∙ β∇H + 𝑞 = 0

𝛽 =
(𝑅(𝐻))

5
3

𝑛|∇𝐻|0.5

 (16) 

   

 Ω(𝐻𝑛+1) − Ω(𝐻𝑛)

Δ𝑡
+∑ 𝛼∇𝐻 ∙ 𝑛 + 𝑄

𝑘
= 0

𝛼(𝐻) =
(𝑅(𝐻))

2
3𝐴𝑘(𝐻)

𝑛|∇𝐻|0.5

 (17) 
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4 Charakteristika Zákolanského potoka a jeho povodí 

Zákolanský potok pramení u obce Pletený Újezd jihovýchodně od Kladna. Tok tedy 

leží ve Středočeském kraji a vede na pomezí Kladenska a Prahy-západ až do Kralup 

nad Vltavou, kde jako levostranný přítok ústí do Vltavy. Celý tok v délce 28,633 km 

je ve správní působnosti státního podniku Povodí Vltavy. Plochy povodí Zákolanského 

potoka je 265,82 km2 a převážně je tvořeno zemědělsky intenzivně obhospodařovanou 

plochou. Nachází se zde ale i několik menších lesů a kolem téměř celé trasy toku jsou 

vysázené stromy nebo je zde jiný rostlinný porost, díky kterému je tok alespoň 

částečně chráněn před zanášením způsobeným odnosem půdy z okolních polí. 

Za účelem intenzivnějšího zemědělského využití okolní půdy byly na toku v minulosti 

prováděny rozsáhlé technické úpravy a tok byl značně narovnán, čímž byl zrychlen 

odtok z povodí. Přestože stav toku není úplně ideální, patří jeho střední část k evropsky 

významným lokalitám, díky výskytu chráněného raka kamenáče (Austropotamobius 

torrentium). Jedná se o nejvíce znečištěný tok s výskytem raka kamenáče v České 

republice. Jeho výskyt je však zdola omezen kvůli problematické kvalitě vody 

přitékající z Dřetovického potoka. (AOPK ČR ©2017b) V současnosti je snaha 

o zlepšování stavu potoka a jeho renaturaci a zlepšení stavu pro různé živočichy. 

Jako příklad lze uvést projekt z roku 2015 na stabilizaci koryta v úseku nad Novým 

mlýnem v obci Noutonice, kde bylo provedeno haťování vrbovými plůtky nebo 

monitoring na výskyt vydry říční v obci Okoř.  

 

Obr. 10 Mapa ČR s vyznačením zájmového území (ČÚZK) 
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Povodí se nalézá v 1. klimatickém regionu definovaném jako teplý a suchý (T1). 

Průměrná roční teplota takto označených lokalit bývá 8-9°C s průměrným úhrnem 

srážek pod 500 mm. Vláhová jistota ve vegetačním období je 0-2 se 40-60% 

pravděpodobností suchého vegetačního období. (VÚMOP ©2018) 

 Z geologického hlediska se Zákolanský potok nalézá v podcelku Kladenské tabule, 

kde zasahuje do Hostivické tabule a Turské plošiny. Jeho okolí je tvořeno písčitými 

slínovci až spongilitickými jílovci. Často se zde vyskytují opuky nebo proterozoické 

fylitické droby a břidlice. Dále je zde možné nalézt nezpevněné sedimenty hlíny a 

písku. Niva zákolanského potoka je relativně plochá až na zářezy a srázy na pomezí 

styku břidlicí s drobami. Dno potoka je hlinité, štěrkovité až kamenité s jemným 

sedimentem. V oblasti výskytu raka kamenáče dno tvoří přirozený substrát. 

Z pedologického hlediska je půda v okolí různorodá, zejména s výskytem kambizemě, 

černozemě a kvartérní spraše. V nivách pak lze nalézt fluvizemě a oglejené partie. 

(AOPK ČR ©2017a) 

4.1 Vymezení zájmového úseku vodního toku 

Zájmový úsek Zákolanského potoka je vymezen katastrálním územím obce 

Noutonice, jehož hranice protíná na 12,182 a 13,653 říčním kilometru. Poloha řešené 

oblasti je znázorněna na Obr. 11. 

 

Obr. 11 Poloha řešené oblasti (Mapy.cz) 
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Tok v řešené oblasti neprochází hlavní obydlenou částí obce, je zde ale chatová osada 

Višňovka a dva bývalé mlýny. Potok na začátku řešené oblasti prochází korytem 

vybudovaným ve vyšší poloze, než je plocha inundace. Toto umístění koryta má 

historický význam, kdy koryto představovalo náhon na Dolský mlýn. Funkce mlýnu 

je již dávno zrušena, a náhon na něj byl zasypán. Tok byl tedy v tomto místě odkloněn 

téměř pravým úhlem do nižší části území. Druhý zmíněný mlýn – tzv. Nový mlýn jako 

náhon využíval samostatné koryto, které je v současnosti využíváno jako napájení 

rybníčků v zahradě Nového mlýna a odtok od rybníčků se vrací do koryta 

před železničním mostem. V řešené oblasti se nalézají čtyři objekty, z nichž tři budou 

zahrnuty do modelu a hydrotechnicky posouzeny. Jedná se o propustek u Dolského 

mlýna ř. km 13,111 (Obr. 13), lávku pro pěší před Novým mlýnem ř. km 12,742  

(Obr. 14) a železniční most za Novým mlýnem ř. km 12,384 (Obr. 15). Provizorní 

lávka u chatové osady Višňovka ř. km 13,436 (Obr. 12) není do modelu zahrnuta. Její 

upevnění je velmi slabé, a tudíž by ji povodeň strhla. V řešeném úseku se také nalézá 

jeden stupeň ve dně a brod.  

 

Obr. 12 L31 - provizorní lávka 

 

Obr. 13 P7 - propustek u Dolského mlýna 

 (Povodí Vltavy s. p. 2006) 

 

Obr. 14 L30 - lávka pro pěší  

(HAŤOVÁNÍ.CZ ©2015) 
 

Obr. 15 Z12 - železniční most 
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5 Metodika 

Cílem práce je stanovení záplavových území a hydrotechnické posouzení části toku 

Zákolanského potoka na základě výstupů hydrodynamického modelu. Pro splnění 

těchto cílů bylo nejprve třeba získat podkladová data z příslušných institucí 

a nainstalování potřebného softwaru jak pro samotnou modelaci, tak pro přípravu 

vstupních dat a vyhodnocení výstupů. 

5.1 Data a podklady 

Část řešeného úseku toku původně sloužila jako náhon k Dolskému mlýnu. Koryto 

bylo pro plnění této funkce napřímeno a vedeno korytem vyhloubeným ve svahu. Dno 

koryta se tak nachází výše než inundační prostor, a proto je nutné řešit záplavová 

území pomocí 2D modelu. Vstupními daty do 2D modelu jsou DMT, vrstva 

se stanovením součinitele drsnosti. zaměřené objektů a vhodné okrajové podmínky. 

5.1.1 ČUZK 

Podkladovou vrstvu pro zakreslení vodního toku, příčných profilů a objektů i podklad 

pro vykreslení výsledných záplavových území představuje mapová vrstva Základní 

mapa České republiky 1:10 000 (ZM 10) získaná od Českého úřadu zeměměřického a 

katastrálního (ČÚZK). Mapa je provedena v souřadnicovém systému S-JTSK Křovák 

East North a jejím obsahem je kromě polohopisu, také výškopis a popis. Polohopis 

zahrnuje komunikace, sídla a objekty, vodstvo, katastrální území a hranice správních 

jednotek, porost, povrch půdy apod. Dále je na mapě znázorněn výškopis v podobě 

vrstevnic a terénních stupňů a popis označující druh objektů, názvy ulic, kóty vrstevnic 

atd. (ČÚZK ©2017) 

Dalším podkladem poskytnutým ČÚZK je Digitální model reliéfu České republiky 

5. generace (DMR 5G) ze sady dat ZABAGED® (výškopis). Vznikl na základě 

leteckého laserového skenování (LLS) a reprezentuje výšku zemského povrchu 

ve formě bodů v nepravidelné trojúhelníkové síti (TIN). LLS využívá ke skenování 

laser ve spektru blízkém k infračervenému, které je vodou plně pohlcováno, a tudíž 

nedokáže mapovat tvar terénu pod vodní hladinou. (Uhlířová, Zbořil 2009)  
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DMR 5G je od ČÚZK dodáván ve formátu XYZ a slouží k vytvoření nezahloubeného 

digitálního modelu terénu (DMT) ve formátu TIN. Tato vytvořená vrstva umožňuje 

generovat příčné profily a výsledné protnutí záplavových čar s terénem mezi příčnými 

profily na základě nadmořské výšky. 

Jako doplňkový materiál k ZM 10 je používána vrstva prohlížecí služby  

WMS-ORTOFOTO umožňující zobrazení území pomocí leteckého měřického 

snímkování. 

5.1.2 ČHMÚ 

Jako horní okrajová podmínka byly použity N-leté průtoky poskytnuté Českým 

hydrometeorologickým ústavem (ČHMÚ), který je odvozoval za maximální dostupné 

období. Hodnoty pro začátek řešeného úsek v profilu na 13.653 ř. km jsou uvedeny 

v Tab. 3.  

N-letost 1 2 5 10 20 50 100 

QN [m3.s-1] 3,40 4,60 7,90 11,9 17,1 26,8 36,4 

Tab. 3 N-leté průtoky na začátku řešeného úseku Zákolanského potoka 

5.1.3 Povodí Vltavy s. p. 

Základní podklad pro schematizaci geometrie toku tvoří zaměřené profily a objekty. 

Údaje z tohoto zaměření jsou uvedeny v Technicko-provozní evidenci Zákolanského 

potoka, která byla zapůjčena státním podnikem Povodí Vltavy, který je v řešeném 

úseku správcem toku. 

5.2 Použité programy 

Pro modelování povodňových průtoků se používají softwarové balíky uvedené 

v kapitole 3.4.2. Pro účel této diplomové práce byl zvolen program HEC-RAS. 

Pro snadnější práci při vytváření modelu a prezentaci výsledků byly dále využity 

programy ArcGIS a HEC-GeoRAS, které jsou s programem HEC-RAS kompatibilní. 

5.2.1 ArcGIS 

ArcGIS je program pro vytváření map a práci s prostorovými daty. V rámci tohoto 

programu vznikly přehledové mapy, ale také v něm bude vytvořen DMR. 

Spolu s nadstavbou HEC-GeoRAS bude program ArcGIS použit pro vytvoření 

geometrických dat vstupujících do modelu, ale také pro zpracování výsledků. 
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5.2.2 HEC-GeoRAS 

HEC-GeoRAS je nadstavbou programu ArcGIS. Využívá se k přenesení dat 

z prostředí ArcGIS do programu HEC-RAS a naopak. Dále také pomáhá 

se zpracováním geometrie toku a inundačního území. Vytváří vrstvy 

s předdefinovanými tabulkami, navržené pro správné převedení informací z ArcGIS 

do HEC-RAS, které pomocí různých funkcí pomáhá vyplnit a také převádí jednotlivé 

vrstvy z 2D na 3D.  

5.2.3 HEC-RAS 

Pro účely diplomové práce byl použit hydrodynamický model programu HEC-RAS, 

jehož bližší popis je uveden v kapitole 3.4.3. 

5.3 Postup zpracování 

V této kapitole je uveden podrobný metodický postup práce od přípravy dat, 

přes sestavení modelu, až po získání výsledného stanovení záplavových území. 

Tato metodika se dá použít pro zopakování řešených simulací (např. při aktualizaci 

některých vstupních údajů). Zároveň je metodiku možné použít pro sestavení modelu 

na jiném toku, kde jsou řešeny obdobné úlohy. 

2D modely jsou založeny na využití zahloubeného digitálního modelu terénu (DMT), 

který je nejprve potřeba vytvořit na základě dat DMR 5G poskytnutých ČÚZK a 

zaměřených profilů od státního podniku Povodí Vltavy. Následně musí být stanovena 

oblast výpočtu se zakreslením okrajových podmínek, definovány oblasti s rozlišnou 

hodnotou součinitele drsnosti, zadány překážky proudění (např. budovy) a objekty 

na toku. Po vytvoření těchto geometrických dat je potřeba definovat okrajové 

podmínky a nastavit vlastnosti výpočtu.  
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5.3.1 Digitální model terénu (DMT) 

Tvorba nezahloubeného DMT 

Prvním krokem v přípravě dat je tvorba 

nezahloubeného digitálního modelu 

terénu (DMT) ze souborů DRM 5G 

ve formátu .xyz poskytnuté ČÚZK. 

Tyto soubory obsahují 3 sloupce čísel, 

popisující souřadnice bodu a jeho 

nadmořskou výšku. Do programu ArcGIS 

se tyto soubory načítají pomocí funkce 

ASCII 3D To Feature Class (Obr. 16). 

Vstupem funkce jsou soubory DMR 5G, 

ve formátu XYZ, které budou vykresleny 

v bodech v souřadnicovém systému  

S-JTSK Křovák East North a uloženy 

do zvoleného adresáře jako nový soubor 

typu shape. Z bodové vrstvy je dále potřeba pomocí funkce Create TIN vytvořit DMT 

ve formátu trojúhelníkové sítě (TIN). Výsledná vrstva TIN je znázorněna na Obr. 17. 

Jak již bylo zmíněno, jedná se o nezahloubený DMT, tedy není zde uvažován tvar 

koryta. Koryto je však popsáno pomocí příčných profilů poskytnutých Povodím 

Vltavy, na základě kterých je možné v programu HEC-RAS provést zahloubení DMT.  

  

Obr. 17 Tvorba vrstvy TIN a znázornění nezahloubeného DMT řešeného úseku toku 

Obr 16 Nahrání dat DMR 5G pomocí funkce ASCII 

3D to Feature Class 
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Linie toku 

Zahloubení DMT je potřeba vytvořit podél osy toku, pro jejíž vyznačení byla použita 

mapa ZM 10 v kombinaci s polohou toku ze zaměření objektů. K vektorizaci osy toku 

se již používá nadstavba HEC-GeoRAS, kde se pomocí nástroje v záložce 

RAS Geometry → Create RAS Layers → Stream Centerline vytvoří nová vrstva, 

do které se pomocí standardních nástrojů 

editace programu ArcGIS zakreslí osa toku 

ve směru jejího proudění. Po uložení editace je 

potřeba přiřadit jméno toku a název větve 

 (Obr. 18) pomocí nástroje Assign River and 

Reach Name (ikonka ID v nástrojové liště).  

Zadané údaje se automaticky propíší do atributové tabulky. Pomocí nástroje 

RAS Geometry → Stream Centrterline atributes → Topology se do atributové tabulky 

přiřadí ID počátečního a koncového bodu toku. Pokud by nebyly známé údaje 

o staničení, je možné tyto údaje vygenerovat pomocí funkce 

RAS Geometry → Stream Centrterline atributes → Lengths/Stations. V případě úseku 

řešeného v této práci je staničení známé a jsou k němu vztaženy hodnoty staničení 

příčných profilů. Proto je vhodné místo poslední 

zmíněné funkce použít funkci Assign River 

Station (ikonka RM v nástrojové liště), do které 

se zadá staničení od/do uvažované proti směru 

proudění v metrech (Obr 19). 

Vytvořenou linii toku je nakonec potřeba 

převést z 2D na 3D. K tomu se používá nástroj 

RAS Geometry → Stream Centrterline atributes 

→ Elevations, do které se zadává vrstva s linií 

toku, DMT a název nové vrstvy (Obr. 20). 

Břehové linie 

Zadávání břehových linií slouží k označení břehové hrany v příčných profilech. 

Umístění břehu by bylo možné označit také později přímo v profilech, ale tato 

vytvořená vrstva bude využita i v následujícím kroku. K vytvoření vrstvy břehových 

Obr. 18 Zadání názvu toku / větve 

Obr. 19 Počáteční a koncové staničení 

Obr. 20 Převedení linie toku z 2D do 3D 
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linií slouží nástroj RAS Geometry → Create RAS Layers → Bank Lines. Poté se 

obdobným způsobem, jako tomu bylo u linie toku, vrstva edituje od vyšších míst 

k nižším. 

Trasa proudění 

Vzdálenosti od předešlého profilu pomůže stanovit vrstva trasy proudění vytvořená 

pomocí RAS Geometry → Create RAS Layers → Flow Path Centraline. Během 

vytváření vrstvy je možnost zvolit, aby se do této vrstvy automaticky nakopírovala 

linie toku, která bude automaticky označena jako „Channel“. Dále se do této vrstvy 

přidávají linie břehů, které je možné v rámci 

editace vykopírovat z vrstvy Bank Lines. 

Nástrojem Assign Flowpath Type (ikona 

se šipkami) se určuje, zda se jedná o pravý 

či levý břeh (Obr. 21). 

Příčné profily 

Zaměřené příčné profily se zakreslují ručně pomocí běžných editačních nástrojů 

do vrstvy vytvořené funkcí RAS Geometry → Create RAS Layers → XS Cut Lines. 

Je třeba dbát na to, aby byly profily vždy vedeny zleva doprava a byly kolmé na osu 

toku. Vytvořeným profilům je třeba přiřadit daný tok (River/Reach Name), staničení 

(Stationing), pozici břehů (Bank Stations – Obr. 22), vzdálenost od předcházejícího 

profilu (Downstream Reach Lengths). Tyto funkce se nalézají v záložce RAS 

Geometry → XS Cut Line Atributes. Po jejich 

spuštění dojde k vyplnění atributové tabulky 

až na sloupeček NodeName, do kterého lze 

přes standardní editaci atributové tabulky zapsat 

název profilu a po ukončení editace se profily 

převedou do 3D pomocí funkce RAS Geometry 

→ XS Cut Line Atributes → Elevations.  

Převod dat z ArcGIS do HEC-RAS 

Data vytvořená v programu ArcGIS s nadstavbou HEC-GeoRAS je potřeba převést 

do programu HEC-RAS. Před samotným exportem je však třeba zkontrolovat/nastavit, 

Obr. 21Nastavení osy proudění a břehů 

Obr. 22 Nastavení břehů profilů 



 

42 

 

jaká data mají být exportována prostřednictvím RAS Geometry → Layer Setup. 

Jednotlivé stránky tohoto nastavení jsou zobrazeny na Obr. 23-26. 

 

Obr. 23 Volba podkladové vrstvy terénu 

 

Obr. 24 Volba vstupních vrstev 

 

Obr. 25 Volba nepovinných (doplňkových) vrstev 

 

Obr. 26 Volba doplňkových tabulek 

 

Export dat z ArcGIS se provede funkcí RAS Geometry → Export Data. 

V programu HEC-RAS je potřeba nejprve založit nový projekt (File → New Project) 

a nastavit jednotky na metrické přes Options → Units System → Systém International 

(Matric Systém). 

Pro import připravených dat je potřeba nejprve otevřít okno pro práci s geometrickými 

daty Edit → Geometric Data. V otevřeném okně se přes File → Import Geometric 

Data → GIS Format vybere soubor exportu z programu ArcGIS. Výsledné zobrazení 

je uvedeno na Obr. 27. 



 

43 

 

 

Obr. 27 Hec-Ras editor geometrických dat 

Úprava profilů 

Profily nahrané do programu HEC-RAS jsou vytvořené nad nezahloubeným modelem 

terénu a není v nich tedy zohledněno koryto toku. Zahloubení je potřeba provést 

na základě zaměření poskytnutého Povodím Vltavy manuálně v programu HEC-RAS 

v editoru příčných profilů v tabulce Cross Section Coordinates. Dále je v editoru také 

potřeba překontrolovat správné nastavení břehů. Pokud by bylo potřeba břehovou 

hranu posunout (např. v důsledku manuálního zahlubování), lze v editoru příčných 

profilů nastavit vzdálenosti břehových hran od začátku profilu v tabulce Main Channel 

Bank Stations. Dalším způsobem nastavení břehových hran je využití nástrojů 

grafického editoru, které umožňují např. označit bod, kam má být břeh nastaven, nebo 

použít tlačítka posouvající břehový bod na nejbližší levý/pravý bod profilu. 

Každému profilu je také potřeba nastavit Manningovy součinitele drsnosti 

pro inundační území a koryto toku. Hodnoty se mohou zadávat jednotlivě 

v tabulkovém editoru příčných profilů (tabulka Manning’s n Value) nebo vyplněním 

tabulky drsností přístupné přes Tables → Manning’s n or k value z okna pro práci 

s geometrickými daty, kde lze vyplňovat hodnoty jednotlivě i hromadně pro více 

profilů najednou. Jelikož jsou profily v této práci použity pouze k zahloubení DMT, 

nikoliv pro výpočet, postačí jednotná hodnota součinitele drsnosti pro všechny profily. 

Nastavení hodnot vstupujících do modelu bude provedeno až při tvorbě 2D modelu. 



 

44 

 

Generování dalších profilů 

Zaměřené profily nepopisují dostatečně trasu toku, proto je potřeba je v editoru 

geometrických dat zahustit pomocí interpolace přes Tools → XS Interpolation → 

Between 2XS’s. Otevřené dialogové okno umožňuje volbu, mezi které profily má dojít 

k interpolaci. Dále pro jednotlivé úseky je potřeba nastavit maximální vzdálenost 

profilů tak, aby dostatečně popisovaly trasu toku. Jako způsob generování souřadnic 

nových profilů (Cut Line GIS Coordinates) je pro tuto diplomovou práci použita 

varianta Generate for display as perpendicular segments to reach invert, která profily 

vygeneruje kolmo na zakreslenou trasu toku. Vytvořené profily je potřeba 

georeferencovat přes GIS Tools → GIS Cut Lines → Accept Displayed Locations. 

Zahuštěný soubor profilů je znázorněn na Obr. 28. 

 

Obr. 28 Zahuštěný soubor profilů 
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Zahloubení DMT 

Zahloubení DMT se provádí v okně RAS Mapper, které se otvírá z hlavního panelu 

programu HEC-RAS. Připravené profily se zobrazí zaškrtnutím políčka Cross 

Sections v levém menu v sekci Geometries. Kliknutím pravým tlačítkem myši 

na název vrstvy obsahující profily se pomocí Export Layer → Create Terrain GeoTiff 

from XS’s (Channel Only) vytvoří zahloubení koryta. Model koryta se spojí 

s nezahloubeným DMT při tvorbě nové vrstvy terénu Tools → New Terrain (Obr. 29). 

Přes tlačítko „+“ se vybírá již vytvořená vrstva zahloubení koryta a soubory 

s nezahloubeným DMT. Pomocí šipek na straně lze měnit pořadí vrstev, přičemž je 

nutné mít vrstvu s tvarem koryta jako první. Nově vzniklá vrstva již obsahuje 

zahloubené DMT a je vhodným podkladem pro tvorbu 2D modelu. 

 

Obr. 29 Spojení DMT a zahloubeného koryta 

5.3.2 Tvorba 2D sítě 

Zadání součinitele drsností a budov 

Manningův součinitel drsnosti do 2D modelu vstupuje jako vrstva s vyznačením území 

s různou hodnotou, která se stanovuje na základě typu povrchu. Tato vrstva typu 

shapefile byla vytvořena v programu ArcGIS, kde byly oblasti různého využití 

zakresleny nad ortofoto mapou pomocí standartní editace. V atributové tabulce je 

potřeba vytvořit jeden sloupec s označením typu využití a druhý s odpovídajícím 

součinitelem drsnosti. Tyto hodnoty jsou v publikacích obvykle zadávány intervalově 

a konkrétní hodnoty pro tento model (Tab. 4) byly stanoveny na základě ortofoto mapy 
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doplněné terénní pochůzkou podle katalogu (Chow 1959). Mapa s vyznačením 

jednotlivých oblastí je uvedena v přílohách (Příloha č.: 1). Během tvorby 2D modelu 

není přímý způsob pro zadávání budov. Jednou z možností, jak tyto stavby v modelu 

zohlednit, je nastavení vysokého součinitele drsnosti. Tato varianta dostatečně blokuje 

proudění v místě budovy, ale zároveň zohledňuje vodu zadrženou uvnitř budovy. 

(Chris G. 2015) Připravená vrstva součinitelů drsnosti se do HEC-RAS nahrává v okně 

RAS Mapper přes Tools → New Land Cover (Obr. 30) pomocí tlačítka „+“. Po přidání 

vrstvy je potřeba zkontrolovat, zda se do kolonky Name field přiřadil sloupec 

s označením typu využití povrchu a do kolonky Mann. N Field sloupec obsahující 

hodnoty součinitele drsnosti. 

Pod sekcí přidávání vrstev jsou dvě 

tabulky umožňující dodatečnou 

úpravu popisu území a hodnot 

součinitele drsnosti. Dále je zde 

potřeba nastavit velikost buňky 

(Cell Size), pro kterou budou 

hodnoty platit a případně změnit 

název a cíl uložení vytvořeného 

souboru.  

Tab. 4 Volba Manningova součinitele drsnosti 

Povrch koryta n Povrch inundace n 

Betonové dno, břehy z kamenného zdiva 0,025 Budovy 10 

Brod 0,025 Dvůr 0,03 

Kamenité dno 0,035 Husté křoví 0,07 

Koryto s vegetačním opevněním 0,035 Les 0,1 

Štěrkové dno, břehy lomový kámen 0,023 Louka 0,03 

Zemní kanál nebo přímé s plevelem 0,03 Pole 0,04 

  Stromy, řídké křoví 0,06 

  Zahrada 0,035 

Obr. 30 Nahrání vrstvy součinitelů drsnosti 
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Hranice 2D oblasti a umístění okrajových podmínek 

Tvorba 2D sítě probíhá opět v editoru geometrických dat, kde je nejprve potřeba 

založit novou vrstvu geometrických dat File → New Geometry Data. Pomocí tlačítka 

2D Flow Area v horní liště se zapne kreslení hranice řešené 2D oblasti. Kreslená 

hranice vymezuje výpočtovou oblast a je proto potřeba odhadnout a lehce nadhodnotit 

dosah záplavy. V místě vstupu vody do modelu i v místech, kde se očekává, že voda 

systém opustí, je potřeba zadat okrajové podmínky pomocí funkce SA/2D Area BC 

lines. 

Tvorba mostů a propustků 

Mosty a propustky lze ve 2D modelech vytvořit pomocí SA/2D Area Connection 

z horní lišty a následně je editovat přes tlačítko z boční lišty. V otevřeném editoru lze 

nastavit metodu výpočtu přetečení a zadávat jezové objekty (Weir / Embankment), 

brány (Gate) a propustky (Culvert). Metoda výpočtu přetečení nabízí volbu mezi 

Normal 2D Equation Domain a Weir Equation. Pokud je vybrána normální 2D 

rovnice, průtok přes horní část struktury se vypočítá jako normální 2D průtok mezi 

buňkami. Druhá varianta pak řeší veškerý průtok nad strukturou pomocí rovnice 

přepadu. V případě, že se očekává ponoření struktury, bývají lepší výsledky při použití 

normální 2D rovnice. Pokud je však struktura vyšší a lze za ní očekávat pokles hladiny, 

je potřeba zvolit rovnici přepadu. (Brunner 2016a) Po otevření nástroje pro tvorbu 

jezových objektů (Obr. 31) se v levé části dialogového okna zadává šířka objektu 

a součinitel přepadu. Součinitel 

přepadu je doporučeno nastavit na 2,6 

pro případ typické horní mostovky, 

resp. 3, pokud je vyvýšená oproti 

okolnímu terénu. (Brunner 2016b) 

Tabulka na pravé straně slouží k určení 

tvaru. Prvním sloupcem (Station) je 

určena vodorovná vzdálenost bodu od 

počátku profilu. Druhý sloupec 

(Elevation) definuje nadmořskou Obr. 31 Tvorba jezových objektů (železniční most) 
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výšku jezu, resp. horní mostovky, přičemž je v daném místě objekt automaticky 

vykreslován od zadané linie až k terénu.  

Pomocí nástroje pro tvorbu propustku (Obr. 32) lze definovat průtočnou oblast. 

V otevřeném okně je potřeba vybrat tvar v kolonce shape a zadat šířku a výšku. Dále 

je potřeba zadat délku propustku (Culvert Length), koeficienty ztrát energie na vstupu 

a výstupu (Entrance / Exit Loss Coeff), součinitele drsnosti před a za objektem 

(Manning’s n for Top / Bottom) a nadmořskou výšku dna na začátku a konci objektu 

(Upstream / Downstream Invert Elev). Tabulka ve spodní části je určena 

k vodorovnému umístění osy propustku do profilu.  

V rámci řešeného úseku jsou pomocí 

těchto nástrojů vytvořeny tři objekty – vysoký 

železniční most u Nového mlýna  

(ř. km 12,384), vyvýšená lávka u brodu 

(ř. km 12,742) a propustek u Dolského mlýna 

(ř. km 13,111). Železniční most je dostatečně 

vysoký a nehrozí jeho úplné zaplavení, proto 

není potřeba řešit jeho uzavření z vrchu. 

Pro schematizaci tedy postačí pouze nástroj 

tvorby jezových objektů, kde mezi 

zakreslením horní hrany mostovky u bočních 

zdí a středového pilíře byla hodnota nastavena 

na výšku dna. Voda zde protéká pouze přes jezovou strukturu odpovídající úrovni dna, 

proto je metoda výpočtu nastavena na normální 2D rovnici. Lávku u brodu je již 

potřeba schematizovat pomocí jezové struktury, ve které je umístěn propustek. 

Jelikož tento objekt je ve tvaru oblouku nad korytem toku, je zde potřeba zvolit 

výpočet pomocí přepadové rovnice. Koeficient přepadu je nastaven, dle již zmíněného 

doporučení, na hodnotu 3 a linie jezové hrany reprezentuje horní mostovku. 

Do vytvořené jezové struktury je nástrojem pro propustek umístěn průtokový otvor 

ve tvaru oblouku (Arch) širokém 3 m a vysokém 2,5 m. Pro propustek u Dolského 

mlýna je zvolena metoda výpočtu přetečení pomocí normální 2D rovnice, protože 

horní mostovka je v úrovni okolního terénu. Schematizace je provedena opět 

kombinací jezu a propustku, přičemž propustek je nastaven jako půlkruh (Semi-Circle) 

o poloměru 0,8 m. 

Obr. 32 Tvorba propustku (lávka u brodu) 
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Breaklines 

Místa s náhlou změnou výšky, jako jsou břehy koryta, budovy a začátky násypů, je 

potřeba ohraničit pomocí nástroje 2D Area Breaklines. Není však potřeba ohraničovat 

objekty, jelikož mají tuto hranici nastavenou ve svém středu automaticky. Vytvářená 

síť má primárně čtvercové buňky, ale u těchto hranic se tvar mění a vzniklé buňky se 

k čárám přerušení přichycují a tím lepe popisují skutečný terén. Po kliknutí levým 

tlačítkem myši jim lze přes Edit Break Line Cell Spacing nastavit nejmenší a největší 

velikost buňky v okolí. Přehled pro všechny hranice i objekty lze zobrazit a také 

editovat přes GIS Tools → Breaklines → Cell Spacing Table. 

Generování 2D sítě 

Vytvoření 2D sítě se provádí spuštěním editace 2D Flow Area v boční liště. Horní část 

zobrazuje okrajové podmínky a připojení (Connections – využité pro tvorbu mostů). 

Levá dolní část umožňuje nastavení různých vlastností vytvářené sítě. První 

z nastavovaných údajů je zde nastavení Manningova součinitele drsnosti, které bude 

použito pro jinak nedefinované oblasti. Pod tímto nastavením je tlačítko Edit Land 

Cover to Manning’s n, kde je tabulka typů využití oblastí s případnou možností úpravy 

hodnoty součinitele drsnosti a pod ní je v kolonce Associated Layer zobrazena cesta 

k souboru obsahujícímu vyznačená území s různým typem povrchu (vytvořený 

na začátku této kapitoly). Pokud soubor připojen není, je potřeba ho přiradit v RAS 

mapper kliknutím pravým tlačítkem myši v boční liště na sekci Geometries a volbou 

Manage geometry Associations. Pravá strana v editoru 2D Flow Area je určena 

k vytváření sítě a informacím o vzniklých buňkách. Pomocí tlačítka Generate 

Computation Points on Regular Interval with All Breaklines se otevře dialogové okno 

pro nastavení rozměrů vytvářených buněk. Potvrzením tlačítkem Generate Points 

in 2D Flow Area dojde k vytvoření 2D sítě a po ukončení editačního okna tlačítkem 

OK se tato síť vykreslí. Vzniklou síť je však potřeba ještě zkontrolovat. Nastavením 

jemnější sítě u čar přerušení mohlo dojít k vytvoření buňky, která má více než 8 stěn, 

což není povoleno. Takovéto buňky jsou označeny výrazným červeným bodem a je 

nutné do těchto míst přes Edit → Add Points přidat další bod, kterým se daná buňka 

rozdělí na dvě s menším počtem stěn. 
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5.3.3 Neustálené proudění 

Nastavení okrajových podmínek 

Zakresleným okrajovým podmínkám je potřeba přiřadit typ podmínky a blíže ji 

definovat. Jelikož je diplomová práce řešena pomocí 2D modelu, musí být řešena 

formou neustáleného proudění a okrajové podmínky se tedy nastaví z hlavního okna 

programu HEC-RAS přes Edit → Unsteady Flow Data. Podmínka na vstupu byla 

nastavena jako Flow Hydrograph. V otevřeném okně je potřeba zvolit datum a čas 

začátku hydrografu a v jakém časové intervalu budou hodnoty zadávány. Na základě 

těchto údajů se do spodní tabulky doplní první sloupec obsahující datum. V druhém 

sloupci je čas od začátku simulace a do třetího sloupce je potřeba zadat odpovídající 

průtoky. Pro cíle práce je potřeba hydrografem nasimulovat ustálené proudění tak, 

že se bude průtok postupně zvyšovat do maximálního průtoku odpovídajícího N-letým 

průtokům získaným od ČHMÚ. Po dosažení maximálního průtoku, se jeho hodnota 

přestane měnit, a hydrograf pokračuje ustáleným prouděním. Okrajové podmínky 

v místech, kde voda může opustit systém jsou nastaveny na Normal Depth s hodnotou 

odpovídající Manningovu součiniteli drsnosti v daném místě. 

Spuštění simulace 

Okno pro nastavení vlastností simulace 

(Obr. 33) se otvírá přes záložku Run → 

Unsteady Flow Analysis v nástrojové liště 

hlavního okna programu HEC-RAS. 

V horní části se zadává název simulace a lze 

zde případně vybírat geometrická data a 

data neustáleného proudění. Ve střední části 

okna se zapínají požadované vrstvy výstupu 

a zadává se časové rozmezí výpočtu. 

Spodní část okna se věnuje nastavení 

výpočetního časového kroku a časového 

kroku pro výstupy. Časový krok pro výpočet se volí na základě vzorce (18), kde je 

rychlost potřeba nejprve odhadnout a postupně upravovat do dosažní stability. 

Velikost časového kroku pro Q100 je 0,2s.  

Obr. 33 Nastavení vlastností simulace 
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∆𝑇 ≤

∆𝑋

𝑉
 (18) 

 ∆𝑇 … výpočetní časový krok [s] 

∆𝑋 … průměrná velikost buňky [m] 

V … rychlost proudění [m.s-1] 

 

   

 

Je-li vše nastaveno, může se spustit výpočet modelu pomocí tlačítka COMPUTE. 

5.3.4 Zobrazení výsledků a export z HEC-RAS do ArcGIS 

Výsledky simulace lze zobrazit v okně RAS Mapper, kde se v levém sloupci aktivuje 

skupina vrstev Results → název plánu, jehož výsledky mají být zobrazeny → 

požadovaná vrstva výsledků. V horní liště je možnost zobrazit maximální a minimální 

hodnoty dosažené během simulovaného času nebo pomocí posuvné lišty nastavit 

požadovaný okamžik. Po kliknutí pravým tlačítkem myši do vykreslené mapy je 

možné zobrazit časový průběh aktivní vrstvy pro dané místo. Dále lze po kliknutí 

pravým tlačítkem myši na linii struktury zobrazit výsledky v aktivním časovém 

okamžiku podél této linie. Podobné grafy lze vytvořit také pomocí tlačítka „+“ 

v záložce Profiles lines v bočním sloupci. 

Výsledky vybrané vrstvy lze exportovat do ArcGIS pro jejich snazší konečné 

zpracování a vytváření map. Příprava dat pro export se provede kliknutím pravým 

tlačítkem myši na požadovanou vrstvu a volbou Edit Map Parameter. Otevřené okno 

je rozděleno do tří částí, kde první slouží k výběru požadované vrstvy, druhá k výběru 

časového okamžiku a třetí pro formu, jakou mají být výsledky prezentovány. Pro účely 

této diplomové práce je volen poslední časový okamžik, kdy je průtok ustálen 

pro danou hodnotu QN. Generování dat vztažených k DMT se v posledním sloupci 

nastaví volbou Stored (saved to disk) → Rasted based on Terrain. Připravená data se 

vyexportují z okna RAS Mapper klinutím pravým tlačítkem myši na danou vrstvu 

v bočním sloupci a volbou Compute/Update Stored Maps. Takto vytvořená vrstva je 

uložena ve složce stejného názvu jako je název plánu simulace a lze vložit do ArcGIS 

standartním způsobem. 
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6 Výsledky 

Sestavený model byl spuštěn pro 4 N-leté průtoky Q5, Q20, Q50 a Q100. Výsledky 

simulace byly použity pro vytvoření hlavních výstupů diplomové práce, kterými jsou 

záplavová mapa (Příloha č. 2), mapy hloubek zatopení (Q5 – Příloha č. 3,  

Q20 – Příloha č.  4, Q50 – Příloha č. 5, Q100 – Příloha č. 6) a mapy rychlostí proudění 

(Q5 – Příloha č. 7, Q20 – Příloha č. 8, Q50 – Příloha č. 9, Q100 – Příloha č. 10). Dalším 

výstupem je hydrotechnické posouzení objektů na řešeném úseku toku. Výsledné 

záplavové území zobrazené v přílohách je vytvořeno na základě předpokladu vzniku 

povodně až v řešené oblasti při průtocích Q5 = 7,9 m3.s-1; Q20 = 17,1 m3.s-1;  

Q50 = 26,8 m3.s-1 a Q100 = 36,4 m3.s-1 v místě koryta na začátku řešeného území. 

Výstupy ukazují, že dochází k rozlivu na většině části toku již při průtoku Q5. Jak již 

bylo zmíněno, část toku byla původně náhonem k mlýnu a koryto vedlo ve vyšších 

polohách. Voda se z tohoto náhonu vylévá na přilehlou louku, díky tomu je na konci 

náhonu koryto kapacitní pro všechny simulované průtoky. Budovy, které se nalézají 

v prodloužení náhonu, nejsou tedy záplavami ohroženy Náhon je prudce sveden do 

nižších poloh, kde se navrací do původního koryta. V tomto místě se také nalézají 

chatové objekty během 5-leté povodně nejsou tyto stavby ohroženy. Simulace pro Q20 

ukazuje, že hladina sice dosáhne k budovám, ale jejich zaplavení by mělo nastat 

až při větších průtocích a mělo by být pouze částečné. (Obr. 34) 

 

Obr. 34 Záplavové území – náhon na mlýn 

  

© ČÚZK 
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U Dolského mlýna se nachází čtyři budovy, přičemž k zaplavení dvou z nich dochází 

již při simulaci průtoku Q5. Další budova je zasažena až při 50-leté povodni, 

a pro průtoky Q100 se záplavy dotýkají všech zmíněných budov. (Obr. 35) 

 

Obr. 35 Záplavové území – Dolský mlýn 

 

Mezi Dolským mlýnem a brodem během 

5-leté povodně dochází k pouze nepatrnému 

zasažení okolních polí, jelikož většina vody se 

rozlévá pouze do přilehlého křoví. Během 100-

letých záplav je rozliv patrnější. Na pravém 

břehu dochází k přelití na louku přes 

příjezdovou cestu a zasažení pole spíše v první 

polovině zmíněného úseku. V druhé polovině 

dochází k rozlivu na pole na levém břehu. 

(Obr. 36)  

 

V okolí brodu a lávky pro pěší dochází k rozlivu již při 5-leté povodni, kdy se ale brzy 

vrací zpět do koryta. Během větších průtoků však část vody pokračuje po poli na levém 

břehu až k Novému mlýnu. V úseku za Novým mlýnem dochází již při 5-leté povodni 

k rozlivu na zahradu, ale budovy nejsou ohroženy. Nový mlýn má také 4 budovy, 

přičemž k jedné se voda velmi přibližuje při simulaci pro Q20. Úrovně dalších dvou 

budov dosahuje voda až při průtocích Q100, kdy je také zaplavována příjezdová cesta 

k Novému mlýnu. Poslední z budov není záplavami ohrožena pro žádný 

ze simulovaných průtoků. (Obr. 37). 

© ČÚZK 

© ČÚZK 

Obr. 36 Záplavové území – úsek mezi Dolský 

mlýnem a brodem 
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V posledním úseku i pro 5-leté průtoky dochází k velkému rozlivu do levé inundace, 

přičemž pravá inundace je zasažena až při simulaci pro Q100. (Obr. 38) 

Mapy znázorňující rychlosti proudění pro všechny průtoky (Příloha č. 7 – 10) ukazují, 

že největší rychlosti jsou na vtoku vody do systému i na výtoku v místě koryta. 

Větší rychlosti jsou také v místě ukončení náhonu. Dále pak v místě vybřežení 

z náhonu a při návratu této vody zpět do koryta. Naopak nejmenší rychlosti v oblasti 

koryta toku jsou u Nového mlýna.  

Součástí diplomové práce je posouzení objektů na toku v řešeném úseku. Jak již bylo 

zmíněno do modelu byly zadávány tři objekty. Na základě výšky hladiny byla 

posouzena jejich kapacita. 

© ČÚZK 

© ČÚZK 

Obr. 37 Záplavové území – brod, Nový mlýn 

Obr. 38 Záplavové území – úsek od železničního mostu ke konci řešeného území 
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Prvním z nich je železniční most za Novým mlýnem (ř. km 12,384). Most je značně 

vysoký, proto voda ani při velkých povodních nedosáhne dolní mostovky, železniční 

doprava by tedy v tomto úseku neměla během povodní narušena. Jak lze vidět  

na Obr. 39, hladina 100-leté povodně je v úrovni cesty procházející pravým obloukem. 

Ostatní simulované průtoky jsou níž než cesta, ale zasahují do středového pilíře. 

Koryto v tomto objektu tedy není kapacitní ani pro menší povodňové průtoky.   

  

Druhým řešeným objektem je lávka pro pěší a kola u brodu (ř. km 12,742). Průtočná 

plocha této lávky pro všechny simulované průtoky je dostatečně kapacitní. Její využití 

během povodní však není možné pro nepřístupnost, protože okolí lávky je zaplavováno 

již při průtoku Q5. (Obr. 40)  

Obr. 39 Železniční most s vyznačením výšek hladin odpovídajících N-letým průtokům 
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Obr. 40 Lávka pro pěší u brodu s vyznačením výšek hladin odpovídajících N-letým průtokům 

 

Posledním řešeným objektem je propustek u Dolského mlýna (ř. km 13,111), který jak 

je znázorněno na Obr. 41 je nekapacitní již pro Q5. 

 

Obr. 41 Propustek u Dolského mlýna s vyznačením výšek hladin odpovídajících N-letým průtokům 
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7 Diskuze 

Přípravě vstupních dat modelu byla věnována velká pozornost, přesto vnáší do modelu 

značnou míru nejistot, které mohou ovlivňovat výsledky. Základním vstupem pro 2D 

modely je zahloubený DMT. Ten byl vytvořen z DMR 5G, který nepopisuje tvar 

koryta pod hladinou, a proto musel být dodatečně zahlouben na základě měřených 

profilů. Vzniklým DMT se do modelu vnáší velká nepřesnost. Jistá míra nepřesnosti 

je způsobena zjednodušeným popisem terénu. Hlavní chyba však vzniká během 

zahlubování. Zahloubení bylo provedeno na základě geodetického zaměření, které je 

považováno za velmi přesné. Vzhledem k jejich nedostatečnému množství však 

musely být pro účely zahloubení interpolovány další, které se již pravděpodobně mírně 

liší od skutečného tvaru koryta. Na toku byly řešeny také objekty, čímž do modelu 

vstupuje další nepřesnost v podobě schematizace a volby koeficientů. Koeficienty byly 

zadávány dle doporučení v manuálu, přesto je potřeba si uvědomit, že se jedná pouze 

o teoretické hodnoty. Dalším vstupem do modelu souvisejícím s terénem je volba 

součinitelů drsnosti. Tyto hodnoty byly stanoveny tabulárně, přičemž v publikacích 

jsou uváděny intervalově. Skutečná hodnota součinitele drsnosti je také časově 

proměnlivá v závislosti na vzrůstu vegetace. Z hydrologického hlediska jsou zdrojem 

nejistot informace o N-letých průtocích. Na řešeném úseku toku ani dříve proti proudu 

není prováděno měření průtoků, proto jsou poskytnuté hodnoty pouze odhadem. 

Na konečné výsledky se také přenáší nejistota způsobená samotným modelem, který 

pro výpočet využívá řadu zjednodušení. 

Jak již bylo zmíněno, průtočný profil koryta je na většině řešeného úseku nekapacitní 

již při průtocích 5-leté povodně. Tuto situaci může do budoucna zhoršit stavba čistírny 

odpadních vod (ČOV), jejíž ústí se uvažuje právě do řešeného úseku toku. V obci 

Lichoceves ani v její části Noutonice v současné době není kanalizace. Předpokládá se 

však značný rozvoj obce (rozšíření přibližně o 2 800 obyvatel), který by měl být 

ukotven do roku 2022 v novém územním plánu obce. Spolu s novou výstavbou má být 

také vybudována ČOV pro nové i stávající obyvatele obou částí obce. (OÚ Lichoceves 

2018) V současné době není ještě zpracován konkrétní projekt a nepodařilo se mi tedy 

zjistit o kolik by se měl průtok v potoce navýšit. Napojení by však mělo být umístěno 

mezi Dolský mlýn a brod. Hlavní nebezpečí navýšení průtoků představuje zvýšení 

povodňových stavů u železničního mostu, kde by docházelo k dřívějšímu a většímu 

zaplavení cesty. Jelikož v současné době dochází při povodních k zaplavení cesty 
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u lávky pro pěší a brodu již při 5-letém průtoku, je v době povodní průjezd 

pod železničním mostem jedinou cestou k Novému mlýnu. Nový mlýn je celoročně 

obýván, tudíž by zaplavení všech příjezdových cest mohlo mít fatální následky. Dále 

je třeba zohlednit i velké finanční škody, které by větší zaplavení zahrady mohlo mít, 

jelikož zahrada slouží částečně jako venkovní sochařská galerie. 

Koryto toku je nedostačující i pro převedení menších povodňových průtoků, proto se 

jako jedna z možných úprav jeví zkapacitnění toku. Při uvažování této úpravy je 

potřeba brát zřetel na skutečnost, že se jedná o chráněnou, evropsky významnou 

lokalitu s populací raka kamenáče. K tvorbě konkrétních návrhů by tedy měli být 

přizváni odborníci z příslušných oborů. Další komplikací této varianty je nedostatečná 

kapacita koryta železničního mostu, která vede ke vzdouvání hladiny. Zde by byla 

nutnost posoudit možnost zahloubení koryta, aby nedošlo k narušení statiky mostu. 

Další možnou variantou, jak zmírnit následky povodní, je realizace suchých poldrů, 

které by během povodní zadržely část vody a tím snížili rozsah záplavy. Tyto poldry 

by mohly být umístěny ve čtyřech lokalitách. První lokalitou je pole pod bývalým 

náhonem, které je již nyní během menších povodňových průtoků částečně 

zaplavováno. Poldr na tomto místě by mohl pomoci ochránit chatové objekty v místě 

návratu náhonu do původního koryta i snížit množství vody v dalších částech toku. 

Druhá lokalita je navrhována před Dolský mlýn, kde by se snížilo množství vody 

v propustku, který je nekapacitní a nemuselo by docházet k zaplavování budov 

Dolského mlýna, ale muselo by se ověřit, zda by nově vzniklé vzdutí zpětně 

neohrožovalo zmíněné chatové objekty. Třetí lokalita pro poldr by mohla být 

před brodem. Výhodou této lokality je větší vzdálenost od budov i širší oblast, kde by 

mohla být voda zadržována. Do této oblasti je také uvažováno vyústění budoucí ČOV, 

čímž by mohl být její odtok v případě povodní zachycen ještě dříve, než se dostane 

ke korytu. Čtvrtá lokalita je navrhována před Nový mlýn. Díky snížení množství vody 

pod železničním mostem by již nedocházelo k zaplavování příjezdové cesty k Novému 

mlýnu, navíc by poldr v této lokalitě již neměl ohrožovat žádné budovy v důsledku 

zpětného vzdutí.  

Třetí a čtvrtá lokalita navržená pro poldr řeší zvýšení vody v důsledku vypouštění 

ČOV a je zde menší nebezpečí zpětného vzdutí, ale ochraňují pouze Nový mlýn. 

U prvních dvou lokalit zase není zohledněn zvýšený průtok v souvislosti s ČOV a je 
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zde třeba brát zřetel na zpětné vzdutí, aby nezpůsobilo ohrožení budov proti proudu. 

Žádná z navrhovaných lokalit pro suchý poldr nezvládne ochránit všechny budovy 

v řešené oblasti Jako vhodná varianta řešení se tedy jeví kombinace více poldrů nebo 

poldru a částečného zkapacitnění toku. 
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8 Závěr 

Cílem této práce bylo hydrotechnicky posoudit řešený úsek vodního toku Zákolanský 

potok. Potok byl posuzován pro průchod průtoků Q5, Q20, Q50 a Q100. Výsledky práce 

ukázaly, že potok tyto průtoky nedovede bezpečně provést a již při průtoku Q5 dochází 

na většině toku k vybřežení.  

Největším problémem se ukázal propustek u Dolského mlýna (ř. km 13,111), který je 

nekapacitní. Zvýšená hladina ohrožuje budovy Dolského mlýna již při průtoku Q5. 

Dalším kritickým místem je návrat náhonu do původního koryta. V tomto místě se 

do upraveného toku navrací voda z inundace, která ohrožuje přilehlé chaty. Další 

nebezpečí představuje železniční most (ř. km 12,384). Koryto v něm není dostatečně 

kapacitní a dochází zde ke vzdutí hladiny. Při průtocích Q20 dochází k ohrožení jedné 

budovy z komplexu Nového mlýna, Q50 ohrožuje již 3 budovy a Q100 se vylévá 

i na příjezdovou cestu. 

Součástí této práce je také hydrotechnické posouzení objektů. Jako dostatečně 

kapacitní se ukázala pouze lávka pro pěší a kola u brodu (ř. km 12,742). Lávka je 

kapacitní pro průtoky Q100, ale již při průtoku Q5 dochází k zaplavení jejího okolí, 

tudíž se během povodní stává nepřístupnou. 

Na základě výstupů modelu byly stanoveny záplavové čáry pro průtoky Q5, Q20, Q50 a 

Q100. Pro všechny simulované průtoky byla také vytvořená mapa hloubek zaplavení 

a rychlostí proudění. 

Hlavním přínosem práce je zhodnocení současného hydrotechnického stavu řešené 

části Zákolanského potoka a popis problematických míst spolu s návrhem na řešení. 

Tato práce může být také užitečná pro obyvatele v této oblasti jako zdroj informací 

o N-letých průtocích a budovách, které budou postiženy. Díky tomu mohou být 

zmírněné majetkové škody, nejen na budovách, ale také na sochách u Nového mlýna. 

Na základě výsledků práce je možné tyto sochy rozestavit tak, aby v případě povodní 

nebylo potřeba je přemisťovat a zároveň nedošlo k jejich poškození. 

Práce by mohla posloužit jako podklad pro zpracování nových záplavových čar 

v rámci projektování zamýšlené ČOV. Dále mohou být výstupy práce využity jako 

zdroj informací při zpracování konkrétních návrhů úprav koryta a jeho okolí. Tyto 

návrhy by bylo vhodné zpracovat tak, aby koryto toku zvládlo bezpečně převést nejen 
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současné povodňové průtoky, ale i zvýšené o očekávaný průtok způsobený vyústěním 

plánované ČOV. Jelikož je Zákolanský potok chráněnou, evropsky významnou 

lokalitou s výskytem raka kamenáče, měly by se návrhy na úpravy toku konzultovat 

s odborníky z příslušných oborů ještě před jejich realizací. 
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